Octet System Data Analysis User Guide

Release 7.1
# Table of Contents

**Chapter 1:**
*Welcome* ........................................ 5  
  *About the Octet System* ...................... 6  
  *What's New in the Octet System Data Analysis Software, Release 7.0* ........ 18  
  *Conventions and Symbols Used in This Guide* .................................. 20  
  *ForteBio Technical Support* .................. 20  

**Chapter 2:**
*Getting Started* ................................. 21  
  *Launching the Octet System Data Analysis 7.1 Software* ....................... 22  
  *Main Menu* ..................................... 23  

**Chapter 3:**
*21 CFR Part 11 Compliance* .................. 27  
  *Octet System 7.0 21 CFR Part 11 Software Overview* ............................ 28  
  *ForteBio GxP Server Module* ............... 29  
  *Selecting a Server Location* ............... 30  
  *Starting a User Session* .................... 33  
  *Compliance Features* .......................... 35  
  *Experiment and Method File Compliance* ........................................... 36  
  *Verifying Digital Signatures* ............... 36  
  *Viewing the Audit Trail* .................... 38  
  *Changing Projects During a User Session* ........................................ 40  

**Chapter 4:**
*Quantitative Analysis* ....................... 43  
  *Working with Experiments* ................. 44  
  *Loading an Experiment for Analysis* ........ 44  
  *Editing Experiments* ........................ 46  
  *Viewing Binding Curves* .................... 53  
  *Closing Experiments* ....................... 57  
  *Analyzing Data* .............................. 57  
  *Analyzing Binding Data* ................. 57  
  *Specifying Analysis Settings* ............. 58  
  *Working with Analyzed Data* ............. 62  
  *Saving Standards Data* .................... 66  
  *Saving Analysis Settings* ................. 66  
  *Processing Batch Quantitation Analysis* ....................................... 67  
  *Creating a Settings_DataAnalysis.ini File* .................................... 68  
  *Selecting Experiments and Running the Batch Analysis* ....................... 70  
  *Exporting Data* .............................. 71  
  *Saving Raw Data* ............................ 71  
  *Saving a Quantitation Results Report* .......................................... 71  

**Chapter 5:**
*Basic Kinetics Analysis* ..................... 75  
  *Working with Experiments* ................. 76  

*Changing the User Password* ............... 41  
*Locking the Application* ..................... 41  
*Ending a User Session* ..................... 42
Accessing Administrator Options .... 172
    Administrator Tabs .............. 173
    User Account Administration .... 174
    Group Administration .......... 178
    Project Administration ......... 181
    Administrator Constants ...... 182
    Event Log ..................... 185

Accessing the ForteBio GxP Server Module Directly 187
Restarting the ForteBio GxP Server Module 190
CHAPTER 1:
Welcome

About the Octet System ................................................................. 6
What’s New in the Octet System Data Analysis Software, Release 7.1 ................. 7
What’s New in the Octet System Data Analysis Software, Release 7.0 .................. 18
Conventions and Symbols Used in This Guide ........................................ 20
ForteBio Technical Support ................................................................ 20
Welcome to the *Octet System Data Analysis User Guide, Release 7.1* for the ForteBio Octet system. This guide explains how to:

- Start a data analysis session and load a quantitation or kinetics experiment (.frd)
- View and analyze the experiment data
- View the analysis results in tabular and graphical formats
- Export analysis results and generate reports

ABOUT THE OCTET SYSTEM

The Octet system enables real-time quantitation or kinetic characterization of biomolecular interactions. A system includes the Octet instrument with the following components:

- Computer
- Hardware
- Software Modules—Data Acquisition and Data Analysis (see Table 1-1)

For more details on the Data Analysis software, see the *Data Analysis User Guide*.

<table>
<thead>
<tr>
<th>Octet Software</th>
<th>Functions</th>
</tr>
</thead>
</table>
| Data Acquisition | - Define a quantitation or kinetic experiment and save the experiment for future use.  
                   - Define custom assays.  
                   - Run the experiment and acquire binding data.  
                   - View and save binding data to a user-specified location. |
| Data Analysis   | - Analyze binding data and view analysis results.  
                   - Export or copy analysis results.  
                   - Generate a report of quantitation or kinetic results in table and graph formats. |

For information on preparing samples for quantitation or kinetics experiments, please see the appropriate ForteBio Octet Biosensor product instructions.
WHAT’S NEW IN THE OCTET SYSTEM DATA ANALYSIS SOFTWARE, RELEASE 7.1

The following features are new for the Octet Data Analysis software, Release 7.1:

1. The Kinetics Analysis tab 2 (Align to Association) is added to the Step 5: Inter-step Correction option list (Figure 1-1).

![Figure 1-1: Align to Association Option](image)

2. For the Quantitation analysis—the interactive binding graph and Group View have been implemented. These features simplify data visualization and add consistency to the existing user interface (Figure 1-2).

Select from the binding graph, sample plate map, result table, X-Y graph, or Group View; corresponding wells are highlighted, respectively, in all views.

![Figure 1-2: Quantitation Analysis—Updated Interactive Binding Graph and Group View](image)
Separate binding graphs are displayed based on the sensor type (Figure 1-3).

Figure 1-3: Separate Binding Graphs Displayed Based on Sensor Type

3. For Quantitation analysis, user-enterable time for the **Beginning Time for Linear Fitting** displays in seconds (Figure 1-4).

![Beginning Time for Linear Fitting](image)

Figure 1-4: Beginning Time for Linear Fitting

4. For Kinetics analysis, the **Align Y Axis to Association** time range is available from 0.0 to 0.0 (Figure 1-5).

![Align Y Axis](image)

Figure 1-5: Beginning Time for Linear Fitting

5. On the Kinetics Analysis tab 3, there is a new GUI for the individual view (Figure 1-6).
   a. The user can edit the display of individual view (at the bottom of individual view graph).
b. The user can select the fields to display in the individual view by clicking Select Fields (Figure 1-7).

The Choose Fields from Result Table dialog box displays (Figure 1-8).

c. In the Available Fields column, select desired fields, click > to move the fields to the Chosen column, and then click OK.
The information on the individual view is changed based on the user selection (Figure 1-9).

6. An **Apply All** option has been added for the Group View graph. To access this option, on the Group View, right-click a graph, and select **Graph Options** (Figure 1-10) > **Apply All** check box.

![Figure 1-10: Graph Options](image)
7. New sensor types have been added to the existing sensor type pull-down list.

To access the new sensor types:

a. Right-click the sensor (or sample information or result table) and select Edit Sample Information (Figure 1-11).

![Edit Sample Information Menu](image)

Figure 1-11: Edit Sample Information Menu

b. On the Edit Sample Information dialog box, click the Sensor Type drop-down menu and select Add a Sensor Type (Figure 1-12).

![Edit Sample Information Dialog Box](image)

Figure 1-12: Edit Sample Information Dialog Box
c. On the Add a Sensor Type dialog box that displays, in the Sensor Type field, enter a sensor type and click OK (Figure 1-13).

![Add a Sensor Type Dialog Box]

Figure 1-13: Add a Sensor Type Dialog Box

d. On the Edit Sample Information dialog box (Figure 1-12), click the Sensor Type drop-down menu again to display the newly added sensor type, NTA (Figure 1-14).

![Displaying the Newly-Added Sensor Type (NTA)]

Figure 1-14: Displaying the Newly-Added Sensor Type (NTA)
8. Parallel sorting on the result table is now supported. To perform this function:
   a. Right-click the result table and select Parallel Sorting (Figure 1-15).

![Parallel Sorting Menu](image)

*Figure 1-15: Parallel Sorting Menu*

b. On the Parallel Sorting dialog box that displays, configure the sorting parameters for the desired results, and click OK (Figure 1-16).

![Parallel Sorting Dialog Box](image)

*Figure 1-16: Parallel Sorting Dialog Box*

The result table is re-sorted based on the configured sorting parameters.

9. A Cycle column has been added on the result table for Multiple Analyte data sets (Figure 1-17).
10. The binding rates of an imported standard curve are displayed in the result table (Figure 1-18).

The name of the standard curve is displayed in the Plate column.
11. On the Quantitation Analysis tab 2, there is a new standard curve GUI feature.
   a. Click the **Standard Curve Within Plate** check box (Figure 1-19) when multiple data sets are loaded. Binding rates and concentrations are calculated according to the standards in the individual plate.

   ![Figure 1-19: Standard Curve Within Plate Check Box](image)

   b. When you click the **Standard Curve by Sensor Type** check box (Figure 1-20), standard curves are generated based on sensor types, and sample binding rates and concentrations are calculated according to the standards with the same sensor type.

   ![Figure 1-20: Standard Curve by Sensor Type Check Box](image)
c. Click **Load Standards** to load three saved standard curves (Standard 1, Standard 2, and Standard 3—see Figure 1-21), and click **Select Standards**.

![Figure 1-21: Three Standard Curves Generated by Sensor Type](image)

The **Select Standards** dialog box (Figure 1-22) displays with all of the standard curves, including the one in the plate.

![Figure 1-22: Select Standards Dialog Box](image)

d. Click to select the standards you want to use, and click **OK**.

e. On the **Standard Curve Equation** dialog box (Figure 1-19: on page 15), click **Calculate Binding Rate**.

Binding rates/concentrations are calculated based on the selected standard curves.

12. An exported standard curve path is displayed on the saved report (on the Standard Curve tab).
13. A customized report feature allows users the flexibility to select and order columns on the saved report, and the report setting is saved as the default for future reports.

To use this feature:

a. On the Report Selection dialog box (Figure 1-23), click Save Report > Select and Order Columns > OK.

b. Select and order the columns and click OK.

c. On the Report Selection dialog box (Figure 1-23), click OK.

On the generated report Results tab, the selected columns and the desired column order are displayed accordingly.

14. For the Octet Pro Software Data Analysis CFR version, all Edit options were disabled.
WHAT’S NEW IN THE OCTET SYSTEM DATA ANALYSIS SOFTWARE, RELEASE 7.0

Table 1-2 lists and describes the new features in the Octet System Data Acquisition software, Release 7.0.

**Table 1-2: Octet System Data Analysis Software—New Features for Release 7.0**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Software for 21 CFR Part 11</td>
<td>The Data Acquisition and Data Analysis software for Octet systems is available in an optional 21 CFR Part 11 version that enables users in GMP and GLP laboratories to comply with 21 CFR Part 11 regulations. This version of the software includes features such as user account management, audit trails and electronic signatures.</td>
<td>28</td>
</tr>
<tr>
<td>New Software for the ForteBio GxP Server Module</td>
<td>During user sessions, the GxP Server module manages and stores this recorded information.</td>
<td>29</td>
</tr>
<tr>
<td>Updated Procedure for Launching the Data Analysis 7.0 Software</td>
<td>Includes new screen captures of latest system desktop icons and procedural text.</td>
<td>22</td>
</tr>
</tbody>
</table>
| Updated Security Menu | This menu now provides the following functions:  
  - Verify document—Utility that tests if a method (.fmf) or data (.frd) file was created using a CFR version of the ForteBio software.  
  - View Audit Trail—Displays the recorded events for CFR documentation. Events may be viewed by project or machine.  
  - Change Project—Switches active projects or run experiment without a project title (“none”).  
  - Change Password—Edits password for an active user.  
  - Server Administration—Modifies settings for users, groups, projects, and constants.  
  - Lock Application—Disables acquisition software with screen lock.  
  - Logoff—Exits program as user. | 25 |
### Table 1-2: Octet System Data Analysis Software—New Features for Release 7.0

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replicate Groups</td>
<td>Replicate groups can be assigned as the sample plate is defined during experiment setup. For quantitation experiments, average binding rate, average concentration and corresponding standard deviation and CV% statistics are calculated for all samples in each replicate group automatically. For kinetics experiments, samples in each replicate group are identified by the same color.</td>
<td>62</td>
</tr>
<tr>
<td>Sample Alerts</td>
<td>The “Sample Alert” highlights data that fit user specified criteria.</td>
<td>65</td>
</tr>
<tr>
<td>Flip Data</td>
<td>Allows acquisition data to be inverted. This function is useful when the observed wavelength shift is negative due to use of large particles, such as liposomes and phage, during the assay.</td>
<td>85</td>
</tr>
<tr>
<td>Grouped View</td>
<td>Displays graphs in custom groupings. This feature allows you to display graphs organized into groups according to sample attribute or results category. This is a highly useful feature when working with large data sets.</td>
<td>126</td>
</tr>
<tr>
<td>X-Y Graph</td>
<td>An X-Y plotting tool that graphs several important parameters such as binding rate, $R^2$, calculated concentration, and residual.</td>
<td>138</td>
</tr>
<tr>
<td>1:2 Bivalent Analyte Model</td>
<td>The model is intended to fit data derived from systems where two molecules of analyte (solution-based molecule) bind to one molecule of the immobilized ligand. The model is available in the Analysis tab (Kinetics mode) &gt; Model menu.</td>
<td>114</td>
</tr>
</tbody>
</table>
CONVENTIONS AND SYMBOLS USED IN THIS GUIDE

**NOTE:** A note presents pertinent details on a topic. For example, general information about tips or alternate options.

**IMPORTANT:** An important message for instances where the assay or procedure will not work if not properly followed.

**WARNING:** A warning informs the user that specific actions could cause irreversible consequences or damage.

Table 25: Octet Instrument Labels

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚡️</td>
<td>Electrical hazard</td>
</tr>
<tr>
<td>⚡️</td>
<td>Heat/hot</td>
</tr>
<tr>
<td>⚠️</td>
<td>Fuse</td>
</tr>
</tbody>
</table>

**FORTEBIO TECHNICAL SUPPORT**

You can contact ForteBio technical support at any of the locations listed in Table 26.

Table 26: ForteBio Technical Support

<table>
<thead>
<tr>
<th>Main Office</th>
<th>European Office</th>
<th>Asia Office</th>
</tr>
</thead>
<tbody>
<tr>
<td>ForteBio, Inc.</td>
<td>ForteBio, UK, Ltd.</td>
<td>ForteBio (Aria Biotechnology Co. Ltd.)</td>
</tr>
<tr>
<td>1360 Willow Road,</td>
<td>83 Victoria Street,</td>
<td>917 Halley Road, Bldg. 4</td>
</tr>
<tr>
<td>Suite 201</td>
<td>Suite 407</td>
<td>Zhangjiang High Tech Park</td>
</tr>
<tr>
<td>Menlo Park, CA 94025</td>
<td>London, SW1H 0HW</td>
<td>Shanghai, China 201203</td>
</tr>
<tr>
<td>USA</td>
<td>UK</td>
<td></td>
</tr>
<tr>
<td>Tel: +1-650-322-1360</td>
<td>Tel: +44-(0)20-31784425</td>
<td>Tel: +86-21-51320387</td>
</tr>
<tr>
<td>Fax: +1-650-322-1370</td>
<td>Fax: +44-(0)20-31787070</td>
<td>E-mail: <a href="mailto:info@fortebio.co.uk">info@fortebio.co.uk</a></td>
</tr>
<tr>
<td>E-mail: <a href="mailto:info@fortebio.com">info@fortebio.com</a></td>
<td>E-mail: <a href="mailto:info@fortebio.co.uk">info@fortebio.co.uk</a></td>
<td></td>
</tr>
</tbody>
</table>
CHAPTER 2:
Getting Started

Launching the Octet System Data Analysis 7.1 Software ........................................ 22
LAUNCHING THE OCTET SYSTEM DATA ANALYSIS 7.1 SOFTWARE

**NOTE:** The installation shall be performed by ForteBio, Inc. personnel only.

**WARNING:** If the Octet system is not used as specified, injury to the user and/or damage to the instrument may result.

**NOTE:** Do not position the Octet instrument such that it is difficult to disconnect the power.

**NOTE:** For information about how to connect the Octet instrument to the computer, refer to the insert sheet that is provided with the Octet instrument.

To launch the system and the Octet Data Analysis software:

1. Turn the Octet instrument on using the power switch located on the external electrical box.

   **NOTE:** The instrument requires a minimum of one-hour warm-up time. It is recommended that you leave the instrument on for a minimum of eight hours prior to use.

2. Launch the Data Analysis software by double-clicking the Data Analysis desktop icon.

   **NOTE:** When using the CFR 11 version of the Octet System Data Analysis software, you are required to log in and start a user session before the software launches. For more information, refer to “Starting a User Session” on page 33.

Launching the Octet System Data Analysis software application displays the main screen (Figure 2-1).
Main Menu

The main menu is located in the upper left corner of the main screen (Figure 2-1). Menu options are described in this section.

Figure 2-1 displays the non-21 CFR Part 11 main menu; Figure 2-2 displays the main menu for the 21 CFR Part 11.

Figure 2-2: Main Menu—21 CFR Part 11 Version of the Data Analysis Software
**File Menu**

The File menu (Figure 2-3) allows users to open and save re-analyze, work with experiments in different modes, save reports, and set port options.

![File Menu](image)

**Figure 2-3: File Menu**

<table>
<thead>
<tr>
<th><strong>Table 2-1: File Menu Commands</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Command</strong></td>
</tr>
<tr>
<td>Load a Folder</td>
</tr>
<tr>
<td>Quantitation Batch Mode</td>
</tr>
<tr>
<td>Kinetics Batch Mode</td>
</tr>
<tr>
<td>Save Report</td>
</tr>
<tr>
<td>Options</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Exit</td>
</tr>
</tbody>
</table>

**NOTE:** When using the 21 CFR Part 11 version of the Octet System Data Analysis software, only 21 CFR Part 11-compliant experiments and re-analyze generated using the 21 CFR Part 11 version of the software can be opened. Files generated using the non-compliant version of the software or with a non-compliant system cannot be opened, and a message indicating this will be presented.
Security Menu

The Security menu is only available in the 21 CFR Part 11 version of the Octet System Data Analysis software.

**NOTE:** The Security menu is only available in the CFR 11 version of the Octet System Data Analysis software. For complete details on menu options, refer to “Compliance Features“ on page 35.

![Security Menu](image)

Figure 2-4: Security Menu

Table 2-2: Security Menu Commands

<table>
<thead>
<tr>
<th>Menu Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify Document</td>
<td>Utility that tests if a method (.fmf) or data (.frd) file was created using a CFR version of the ForteBio software.</td>
</tr>
<tr>
<td>View Audit Trail</td>
<td>Displays the recorded events for CFR documentation. Events may be viewed by project or machine.</td>
</tr>
<tr>
<td>Change Project</td>
<td>Switches active projects or run experiment without a project title (“none”).</td>
</tr>
<tr>
<td>Change Password</td>
<td>Edits password for active user</td>
</tr>
<tr>
<td>Server Administration</td>
<td>Modifies settings for users, groups, projects and constants.</td>
</tr>
<tr>
<td>Lock Application</td>
<td>Disabled the Octet System Data Analysis software with a screen lock. A password is required to unlock the program.</td>
</tr>
<tr>
<td>Logoff</td>
<td>Exits the program. A password is required to log in again.</td>
</tr>
</tbody>
</table>
Help Menu

The Help menu provides access to software and instrument support information.

Figure 2-5: Help Menu

Table 2-3: Help Menu Commands

<table>
<thead>
<tr>
<th>Menu Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Analysis User Guide</td>
<td>Opens the online Octet System Data Analysis Software User Guide.</td>
</tr>
<tr>
<td>ForteBio Web Site</td>
<td>Opens a web browser and displays the ForteBio web page (<a href="http://www.fortebio.com">www.fortebio.com</a>).</td>
</tr>
<tr>
<td>About ForteBio Data Analysis</td>
<td>Displays software, user, and instrument information.</td>
</tr>
</tbody>
</table>

NOTE: Clicking the ForteBio logo (in the upper right corner of the main screen) also displays the About window.
CHAPTER 3:
21 CFR Part 11 Compliance

Octet System 7.0 21 CFR Part 11 Software Overview .................................................. 28
ForteBio GxP Server Module ....................................................................................... 29
Selecting a Server Location ....................................................................................... 30
Starting a User Session ............................................................................................. 33
Compliance Features ................................................................................................. 35
OCTET SYSTEM 7.0 21 CFR PART 11 SOFTWARE OVERVIEW

The Data Acquisition and Data Analysis software for Octet systems is available in an optional 21 CFR Part 11 version that enables users in GMP and GLP laboratories to comply with 21 CFR Part 11 regulations. This version of the software includes features such as user account management, audit trails and electronic signatures. In addition, the 21 CFR Part 11 version utilizes the ForteBio GxP Server module to manage the information recorded during user sessions. This chapter explains how to use the ForteBio GxP Server module, compliance features and administrative functions specific to the 21 CFR Part 11 versions of the Data Acquisition and Data Analysis software.

NOTE: The 7.0 21 CFR Part 11 Data Analysis software only opens data files generated in CFR data acquisition. 7.0 21 CFR Part 11 files from software version 6.X are fully compatible with the 7.X 21 CFR Part 11 software.

NOTE: For details on how to install the Octet System Data Acquisition or Data Analysis software, see Appendix B, 21 CFR Part 11 Software Administrator Options on page 155.
FORTEBIO GXP SERVER MODULE

When the Data Acquisition or Data Analysis 7.0 21 CFR Part 11 software is launched, users are prompted to logon to the ForteBio GxP Server module. This initiates a user session where all system, software and user events are recorded. During user sessions, the GxP Server module manages and stores this recorded information. User sessions are closed when the user logs out or a set period of inactivity is reached. A new user session is initiated each time a user accesses the software.

**NOTE:** For details on how to install the ForteBio GxP Server module, see Appendix B, 21 CFR Part 11 Software Administrator Options on page 155.

**NOTE:** The ForteBio GxP Server is required for 21 CFR Part 11.

**NOTE:** The GxP Server can be installed in multiple locations with user selection of the employed copy at the launch of the Acquisition or Analysis software, although a single copy per network is recommended by ForteBio to ensure that all records are saved to one location.
SELECTING A SERVER LOCATION

**NOTES:**

Please contact your administrator to determine best location to use for the GxP Server module.

Once the GxP Server module host location is selected, this location should be used as the default selection for the user account. It does not need to be reselected each time a new user session is initiated.

Users must select the host location of the GxP Server module during the login process. The GxP server can be run on the local host computer where the Data Acquisition or Data Analysis software is installed or from a network location.

To select a server location:

**NOTE:** You must select the host location of the GxP Server module during the login process. You can use the GxP Server on the local host computer where the Data Acquisition or Data Analysis software is installed, or from a network location.

1. Launch the Data Analysis software by double-clicking the Data Analysis desktop icon. The Login dialog box displays (Figure 3-1).

![Login Dialog Box](Image)
2. Click ... (browse) to select a Server location.

The Authentication Server dialog box displays (Figure 3-2).

![Authentication Server Dialog Box](image)

Figure 3-2: Authentication Server Dialog Box

3. Click Default to recall the default server settings of localhost and Port 2002.
   - **Local host**—If the local computer is to be used as the GxP Server module host, click the Localhost check box. Change the Port number if necessary.
   - **Remote host on same subnet**—If the GxP Server module is hosted on the same subnet, deselect the Localhost check box and click Find. A list of potential GxP Server module addresses will be listed. Choose the desired location from the list and click OK.

![Choose Server Address](image)

Figure 3-3: Choose Server Address

- **Remote host on another subnet**—If the GxP Server module is hosted on a different subnet, deselect the Localhost check box. Enter the IP address of the computer hosting the GxP Server module.
4. When the GxP Server module host location has been selected or entered, click OK to save changes and exit the Authentication Server dialog box.

The GxP Server module location is listed as the Server in the Login dialog box (Figure 3-5).

![Authentication Server Dialog Box](image)

**Figure 3-4: Authentication Server Dialog Box**

![Login Dialog Box—GxP Server Information](image)

**Figure 3-5: Login Dialog Box—GxP Server Information**
STARTING A USER SESSION

NOTE: Before starting your first user session, contact your administrator to determine the GxP Server module host location to use.

To start a user session:
1. Launch the Data Acquisition or Data Analysis software by double-clicking the respective desktop icon. The Login dialog box displays (Figure 3-1: on page 30).

2. Confirm that the Server location is correct. If not, see “Selecting a Server Location” on page 30.
   • If the local machine is to be used as the GxP server, ensure that Localhost is selected.
   • If a remote machine is to be used and it is located on the same subnet, de-select Localhost and click Find to display a list of potential GxP server addresses. Choose the desired GxP server from this list and click OK. Click OK in the Authentication Server dialog to finish. The new GxP server should be listed in the Login dialog box (next to Server).
   • If a remote machine is to be used and it is located on a different subnet, de-select Localhost and enter the IP address of the machine running the GxP server. Click OK to close the authentication server.

3. Select your login name from the User drop-down list (Figure 3-6). (For the first time logging in, select Administrator.)

NOTE: To start an administrator session, select Administrator in the User drop-down list.
4. Enter your password in the Password field. Click ? for a password reminder if needed (Figure 3-7). (For the first time logging in, leave the Password field blank.)

![Password Reminder Option](image)

Figure 3-7: Password Reminder Option

5. Optional. Select a project from the Project drop-down list (Figure 3-8). (For the first time logging in, leave as (none).)

![Project Selection](image)

Figure 3-8: Project Selection

6. Click OK.

The Data Acquisition or Data Analysis software launches and starts the user session. During the session, the user account and project selected at login are displayed in the Data Acquisition software status bar.
NOTES:
Software operation may be restricted based on your user privileges. For more information on user privileges, please contact your administrator.

User sessions are automatically locked after a period of inactivity which is set by the administrator. The Login box will display and a message indicating the session has been locked will be shown. You can choose to log back into the session or log off at this time. User sessions will not be locked during experimental data acquisition. **NOTE:** To create and edit new users, groups, and projects, see “User Account Administration” on page 174, “Group Administration” on page 178, and “Project Administration” on page 181.

COMPLIANCE FEATURES
You can access the 21 CFR Part 11 compliant features provided in the 21 CFR Part 11 versions of the Data Acquisition and Data Analysis software by selecting the Security menu from the main menu (Figure 3-9).

![Security Menu — Octet System Data Analysis Software](image)

**Figure 3-9:** Security Menu — Octet System Data Analysis Software

NOTES:
The **Server Administration** option in the Security menu can be accessed only if you have administrator or review privileges.

Security menu options in the Data Acquisition and Data Analysis software applications are identical.
Experiment and Method File Compliance

When using the 21 CFR Part 11 version of the Octet System Data Acquisition software, only 21 CFR Part 11 compliant experiments and method files generated using the 21 CFR Part 11 version of the software can be opened. Files generated using the non-compliant version of the software cannot be opened, and a message indicating this will be presented.

Verifying Digital Signatures

The electronic signature of method (.fmf) and data (.frd) files can be verified to ensure they were generated using 21 CFR Part 11 compliant software.

To verify digital signatures:


   The Verify Digital Signature dialog box displays (Figure 3-10).

   ![Verify Digital Signature](image)

   Figure 3-10: Verify Digital Signature

2. Click ... to browse for the desired .fmf or .frd file.

   **NOTE:** When verifying digital signatures, both method (.fmf) and data (.frd) files can be selected in the Data Acquisition and Data Analysis software.
To change the file type available for selection, click the file type box and select a different format (Figure 3-12).

3. Select the desired file and click OK.
A message displays in the Verify Digital Signature dialog box, indicating file compliance status (Compliant or Non-Compliant) (Figure 3-13).
Viewing the Audit Trail

The Audit Trail displays a historical log of user, system and software events recorded during user sessions. To view and display the Audit Trail, click Security > View Audit Trail (Figure 3-14).

Figure 3-14: Audit Trail
NOTE: Events displayed in the Audit Trail are those associated with the user account that is currently logged in and active only.

**Sorting Events in the Audit Trail**

Events in the Audit Trail can be sorted by clicking any of the column headers (Figure 3-15).

![Figure 3-15: Events Listed in the Audit Trail](image)

**Viewing Events for a Specific Project or Computer**

By default, the events initially displayed in the Audit Trail are those associated with the project selected at login and the machine (computer) currently being used. To view events for a specific project or computer, click the Project or Machine drop-down list and select an entry (Figure 3-16).

![Figure 3-16: Viewing a Specific Project in the Audit Trail](image)

NOTE: Selections can be made in either one or both of the Project or Machine drop down lists.

The list only displays events for the selected entries (Figure 3-17).
In addition to the specific project and machine selections, the following list options are also available:

- **(any)**—Displays all project and/or machine events for the user account.
- **(none)**—Displays all project or machine events not associated with a specific project (Project list only).

### Changing Projects During a User Session

During an active session, you can switch to another project in the Data Acquisition or Data Analysis software without having to log out.

To change projects during a user session:

1. **Click Security > Change Projects.**
   
   A list of projects assigned to your user account displays with the active project highlighted (Figure 3-18).

2. **Select the desired project from the list.**
   
   The selected project becomes the active project for the user session.
Changing the User Password

To change the user password:

1. Initiate a new user session with your existing password.
2. When the software launches, click Security > Change Password.
   
   The Change Password dialog box displays (Figure 3-19).

3. Enter the Current password for your user account. Click ? for a password reminder.
4. Enter the New Password, confirm the new password, and optionally enter a Password reminder.
5. Click OK to save the changes and exit.

Locking the Application

The Data Acquisition or Data Analysis software can be locked during a user session to prevent another user from interrupting a session or experiment. When the application is locked, any experiments started will continue to run.

To lock the Octet System Data Acquisition software application, click Security > Lock Application.

The Octet System Data Acquisition software is placed in locked mode immediately and the Application Locked window displays (Figure 3-20).
The application will remain locked until it is unlocked or the active user logs off.

- **Unlock**—To resume the user session, enter your password and click Unlock.
- **Log off**—To discontinue the user session, click Logoff.

**Ending a User Session**

To end a user session:

2. Click OK in the dialog box displayed.
CHAPTER 4:
Quantitative Analysis

Working with Experiments ................................................................. 44
Analyzing Data .................................................................................. 57
Saving Standards Data ....................................................................... 66
Saving Analysis Settings .................................................................... 66
Processing Batch Quantitation Analysis ............................................. 67
Exporting Data ................................................................................... 71
WORKING WITH EXPERIMENTS

A quantitation experiment enables you to determine sample concentration using a reference set of standards. After an experiment is run, start a data analysis session (double-click the icon on the desktop); see “Analyzing Binding Data” on page 57.

Loading an Experiment for Analysis

A data analysis session can be used to:

- Load and analyze an experiment.
- Re-analyze an experiment.

**NOTE:** More than one experiment can be opened during a session. If multiple quantitation experiments are open, the analysis includes the data from all of the biosensors that are check marked in the Results tab.

**NOTE:** When using the 21 CFR Part 11 version of the Octet System Data Acquisition software, only 21 CFR Part 11-compliant experiments and re-analyze generated using the 21 CFR Part 11 version of the software can be opened. Files generated using the non-compliant version of the software or with a non-compliant system cannot be opened, and a message indicating this will be presented.

To load an experiment:

1. On the desktop, click the icon, or click the Windows Start button and select All Programs > ForteBio > Data Analysis 7.0.

   The Data Selection tab displays (Figure 4-1).

   ![Figure 4-1: Data Selection Tab](image)

2. Load an experiment: right-click the experiment folder in the workstation directory tree and select Load Folder, or on the menu bar, click File > Load a Folder.

3. In the Loading Files dialog box, enter the folder name or click the Browse button, select the desired folder, and click Load.

   The experiment is added to the Loaded Data directory tree (see Figure 4-2 example).
4. In the Loaded Data directory, click the experiment name to open.

The binding curves, sample plate, and sample plate table appear (Figure 4-3).

5. Repeat steps 2–3 to load and open another experiment.
NOTE: When multiple experiments are loaded, select an experiment by clicking its tab above the binding chart (in the Data Selection window), or click the experiment name in the Loaded Data directory tree.

Editing Experiments

The Octet System Data Acquisition software enables you to change sample designations, standard concentrations, or exclude samples from analysis. For example, you can exclude a standard that does not meet the sample $r^2$ or residual threshold, then re-analyze the data. You can also modify some processing parameters.

Changing Sample Designations

To change sample designations:

1. Click the Data Selection tab, then perform one of the following tasks:
   - In the sample plate map, select the well(s), right-click, and select one of the following options (see left image in Figure 4-4):
     - Change to Standard
     - Change to Unknown
     - Change to Control
     - Change to Reference
     - Edit Sample Information
   - In the results table, right-click a table cell and make a selection from the drop-down menu (see right image in Figure 4-4).

![Selecting wells in the sample plate map](Selecting wells in the sample plate map)

![Selecting a cell in the Well Type column of the results table](Selecting a cell in the Well Type column of the results table)

Figure 4-4: Changing Sample Designations
Excluding/Including Samples from Analysis

To toggle sample analysis in the Results window, perform one of the following tasks:

- In the sample plate map, select the well(s), right-click and select Exclude Wells. If the selection is already excluded from analysis, select Include Wells to return (include) the samples to the analysis.

- In the results table, to exclude wells, de-select the check box in the first column, or right-click the selected rows and select Exclude Selected Wells. If the selection is already excluded from analysis, click the check box for the desired rows, or right-click the desired rows, and select Include Selected Wells.

![Figure 4-5: Excluding Samples from Analysis](image-url)
**Editing Standard Concentration or Well Information**

To edit standard concentration or well information:

1. Click the **Data Selection** tab.
2. In the results table, click a **Conc.** or **Well Info** cell, and enter the desired information. (To access a shortcut menu of editing commands, right-click the cell.)

![Figure 4-6: Data Selection Window—Editing Sample Information](image)

**Editing Processing Parameters**

To edit processing parameters:

1. Modify the following parameters as appropriate:
   - **Read time**—The amount of data that is analyzed.
   - **Zero concentration threshold**—Binding rates that are less than the zero concentration threshold are considered zero.
   - **Low concentration threshold**—Clicking **Calculate binding rate** causes the initial rate to be calculated using both a linear and exponential equation. The low concentration threshold determines which value is reported in the results table. Changing this threshold can improve the precision of low concentration samples.
     - If the result from a linear fit is below the low concentration threshold, then the value from the linear fit is reported in the analysis table.
     - If the result from a linear fit is greater than the low concentration threshold, then the value from the exponential fit is reported in the analysis table.
2. In the Results window, select the cell to edit and enter a new value. Or, right-click the cell to access a shortcut menu of edit commands. The modified parameters are saved in the Settings_DataAnalysis.ini file when you click Calculate Binding Data!

**Figure 4-7: Editing Processing Parameters in the Results Window**

**Defining Replicate Groups**

The Replicate Group feature enables data to be organized into custom groups during analysis (see Figure 4-8). Replicates can be defined during acquisition (or analysis) as a group. For each group, the average binding rate, average concentration, and corresponding standard deviation, CV% are calculated.

To define replicate groups:

1. Enter replicate grouping information in the Results table: right-click and select Edit Sample Information (Figure 4-8).
Assigning Replicate Groups in the Sample Plate Map

To assign Replicate Groups in the Sample Plate Map:

1. Select the samples to group, right-click and select Set Well Data.
2. In the Set Well Data dialog box (see Figure 4-9), enter a name in the Replicate Group box and click OK.

**NOTE:** Replicate Group information can also be entered in the Octet System Data Acquisition software.
3. Repeat the previous steps to assign new samples to the existing Replicate Group, or to designate another set of samples to a new Replicate Group. Multiple groups can be used in an experiment.

**IMPORTANT:** The Octet System Data Analysis software will only recognize and group samples that use the same Replicate Group names—spacing and capitalization must be identical. For example, samples assigned to Group 2 and group2 are treated as two groups.

**NOTE:** When performing a Multiple Analyte experiment in Data Acquisition, if the same Replicate Group name is used with different biosensor types, they will be treated as separate groups. Statistics for these groups will be calculated separately for each biosensor type.

Wells in the Sample Plate Map will show color-coded outlines as a visual indication of which wells are in the same group (see Figure 4-10).

![Sample Plate (96 wells)](image)

**Figure 4-10:** Replicate Groups Displayed in Sample Plate Map

The Sample Plate Table updates with the Replicate Group names entered (see Figure 4-11).
Assigning Replicate Groups in the Sample Plate Table

To assign Replicate Groups in the Sample Plate Table:

1. Double-click the desired cell in the Replicate Group table column.
2. Enter a group name (see Figure 4-12).

NOTE: The right-click menu is context-dependant. Right-clicking on a cell where the value is not highlighted and in edit mode opens the Sample Plate Map menu used to designate sample types.
3. Repeat the previous steps to assign new samples to the existing Replicate Group, or to designate another set of samples to a new Replicate Group. Multiple groups can be used in an experiment.

**IMPORTANT:** The Octet System Data Analysis software only recognizes and groups samples that use the same Replicate Group names where spacing and capitalization must be identical. For example, samples assigned to Group 2 and group2 are treated as two groups.

**Viewing Binding Curves**

To view binding curves, in the sample plate, select a well(s), or in the sample plate table, select a row(s).

To select non-adjacent rows or wells, press and hold the Ctrl key while clicking the wells or rows.

![Figure 4-13: Selecting Sample Wells or Rows to Display in the Binding Curve Graph](image-url)
**Viewing Options**

*Table 4-1: Viewing Options in the Data Selection Window*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align X</td>
<td>Select this option if there is an artifact at the beginning of the binding step to remove. Enter a time (seconds) at which to start the alignment.</td>
</tr>
</tbody>
</table>
| Reference Subtraction Average of | If the experiment includes reference biosensors, select the Reference Subtraction option and select one of the following:  
  - All—Computes the average binding curve from the reference wells and subtracts this average from each sample curve.  
  - Row—If a row includes both samples and references, the Octet System Data Acquisition software computes the average reference curve for the row and subtracts this curve from the samples in the same row.  
  - Column—If a column includes both samples and references, the Octet System Data Acquisition software computes the average reference curve for the column and subtracts this curve from the samples in the same column. |
| Ignore errors in files when loading | If this option is selected, the Octet System Data Acquisition software ignores errors in data files. All data files, regardless of errors or runtime issues, will be loaded for analysis. |
| Show All Traces             | Displays all binding curves.                                                                                                                |
| Flip Data                   | The Flip Data function inverts signals from positive to negative or from negative to positive. This is used most often when the observed nm shift is negative due to the presence of large analytes, such as phage, cells, and lipoparticles on the biosensor surface. For examples of flipping data, see Figure 4-14 and Figure 4-15. |
| Grouped View                | Displays graphs in custom groupings. Choose this option to display graphs organized into groups according to sample attribute or results category. This is a highly useful feature when working with large data sets.  
  - Options—Click to show the Grouped View Options dialog box.  
  - Refresh—Updates the graph display. |
Table 4-1: Viewing Options in the Data Selection Window (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Legends</td>
<td>Select the sample information displayed in the legend. Options include Sensor, Sample, Sample ID, Group, and Concentration.</td>
</tr>
</tbody>
</table>

**Figure 4-14:** Flip Data—Example of Flipping Data to Example in Figure 4-15

**Figure 4-15:** New Flip Data from Figure 4-14
**Opening Binding Curve in Separate Window**
To open the binding curve chart in a separate window, double-click the graph.

**Customizing Appearance of Graph or Binding Curve**
To customize the appearance of the graph or a binding curve; see Figure 4-16. Right-click the graph or a curve for a shortcut menu of display options.

- Hover over a binding curve to display a tooltip of the X-Y coordinates.
- Right-click the graph to view a shortcut menu of display options.
- Right-click a curve to view a shortcut menu of display options.
- Right-click the graph and select **Toolbar**. Toolbar buttons enable you to save, copy, or print the graph.

![Figure 4-16: Viewing Binding Curves](image.png)
Closing Experiments

To close an experiment, in the Loaded Data directory tree, right-click the experiment name and select Remove Run (see left side of Figure 4-17).

To close all experiments in the Kinetics or Quantitation folder, right-click the folder and select Remove All (see right side of Figure 4-17).

Figure 4-17: Closing a Selected Experiment (left) or All Experiments (right) in the Quantitation or Kinetics Folder

ANALYZING DATA

More than one experiment can be opened during a session. If multiple quantitation experiments are open, the analysis includes the data from all of the biosensors that are selected in the Results tab.

NOTE: When analyzing a large number of experiments, batch mode may be more convenient. For more details on batch analysis, see “Processing Batch Quantitation Analysis” on page 67.

Analyzing Binding Data

To analyze the binding data:

1. Start an analysis session and select the experiment(s) to use.
2. Select a standard curve equation.
3. If the sample plate does not include standards, load a standards file (.fsc).
4. Confirm or set new values for the processing parameters.
5. Calculate the binding rate.
**NOTE:** For information on preparing biosensors, see the product insert packed with the biosensors. For information on data acquisition, see the Data Acquisition User Guide.

**Specifying Analysis Settings**

To specify analysis settings:

1. If the experiment includes reference biosensors, click the Reference Subtraction Average of check box (Figure 4-18) and select to average the data by one of the following:
   - **All**—Computes the average binding curve from the reference wells and subtracts this average from each sample curve.
   - **Row**—If a row includes both samples and references, the Octet System Data Acquisition software computes the average reference curve for the row and subtracts this curve from the samples in the same row.
   - **Column**—If a column includes both samples and references, the Octet System Data Acquisition software computes the average reference curve for the column and subtracts this curve from the samples in the same column.

![Figure 4-18: Reference Subtraction Average of Methods](image)

2. Confirm the sample designations (for details, see “Changing Sample Designations” on page 46).
3. Confirm the standard concentrations (for details on changing standard concentration, see “Editing Standard Concentration or Well Information” on page 48).

4. Click the Results tab and select samples to include in the analysis (for details, see “Excluding/Including Samples from Analysis” on page 47).

Figure 4-19: Results Window

5. Select a standard curve equation from the drop-down list:
   - Linear Point to Point—The Octet System Data Acquisition software connects the points of the standard curve with straight line segments.
   - Dose Response–4PL (Default; Unweighted)—A symmetrical dose response curve. No points are weighted during the curve fitting.
   - Dose Response–4PL (Weighted Y2)—A non-symmetrical dose response curve with weighting applied as 1/Y2.
   - Dose Response–4PL (Weighted Y)—A non-symmetrical dose response curve with weighting applied as 1/Y (as Y increases, weighting decreases).
   - Dose Response–5PL (Default; Weighted Y2)—A non-symmetrical dose response curve with weighting applied as 1/Y2.
   - Dose Response–5PL (Unweighted)—A symmetrical dose response curve. No points are weighted during the curve fitting.
   - Dose Response–5PL (Weighted Y)—A non-symmetrical dose response curve with weighting applied as 1/Y.
NOTE: The Octet System Data Acquisition software uses the data from the standards in all of the open experiment(s) to generate one standard curve. Standards with the same concentration are treated as replicates. Remove any standards or samples that you do not want to include in the analysis. (For more details on excluding samples, see “Excluding/Including Samples from Analysis” on page 47. Alternatively, an experiment can be analyzed using only the standards from the same experiment plate or from a user-selected experiment).

6. Optional. If multiple experiments are open and you want to analyze an experiment using the standards from the same experiment plate, click the Calibrate within plate check box.

NOTE: When two quantitation datasets are opened, you have the option to merge data across plates. This happens, by default, if the Calibrate within plate check box is not checked. Further to this, replicate groups of standards will be merged and the statistics will be calculated across the entire new replicate group, BUT replicate groups of unknowns will not be merged.

NOTE: You can navigate between multiple experiments using the tabs above the sample plate map.

7. Optional. Analyze the data using standards from another experiment:
   a. Click Load Standards.
   b. In the displayed dialog box, select a standard curve (.fsc) and click Open.
   c. Click the Use standards from loaded file check box.

8. Confirm or edit the processing parameter settings (for details, see “Editing Processing Parameters” on page 48)
   - **Binding Rate Equation**—The curve-fitting equation that models the binding data.
     - **Initial Slope**—Calculates the initial slope of the acquired quantitation data (nm/second). Choose this equation for a basic quantitation or basic quantitation with regeneration experiment.
     - **R equilibrium**—This equation is recommended for an advanced quantitation experiment that includes amplification. This equation uses the calculated equilibrium, not the initial slope, to model the data.
   - **Read Time**—The length of acquired data analyzed (seconds).
• **Zero Conc. Threshold**—Calculated binding rates less than the zero concentration threshold are reported as zero in the results table.

• **Low Conc. Threshold**—Clicking Calculate Binding rate! causes the initial rate to be calculated using both a linear and exponential equation. The low concentration threshold determines which value is reported in the results table. If the result from a linear fit is below the low concentration threshold, then the value from the linear fit is reported in the analysis table. If the result from a linear fit is greater than the low concentration threshold, then the value from the exponential fit is reported in the analysis table. Changing this threshold can improve the precision of low concentration samples.

9. **Click Calculate Binding Rate!**

The standard curve and results table display (Figure 4-20).

![Figure 4-20: Results Window for a Quantitation Experiment](image)
**Working with Analyzed Data**

On the Results window, the following parameters (see columns) define the analyzed data:

- **Check boxes** toggle the corresponding well's data between inclusion and exclusion from the data analysis:
  - To exclude a sample from subsequent analyses, de-select the corresponding biosensor number in the results table and click **Calculate Binding Rate!** to re-analyze. Or, select one or more wells in the results table, right-click and select **Exclude Wells**.
  - To include a sample in subsequent analyses, checkmark the corresponding biosensor number in the results table and click **Calculate Binding Rate!** to re-analyze. Or, select one or more wells in the results table, right-click and select **Include Wells**.

- **Plate**—A unique number assigned to individual sample plates.
- **Sensor**—The biosensor number.
- **Index**—A unique number assigned to each data point during data analysis.
- **Dilution factor**—The dilution factor used to prepare the assay sample. The dilution factor is multiplied by the well concentration to determine the **calculated concentration**.
- **Well concentration**—The concentration of the analyte determined from the standard curve. The well concentration is multiplied by the dilution factor to determine the **calculated concentration**.
- **Flip**—Inverts the magnitude of all data. Used during analysis of large particles where negative signals can be observed.
- **Information**—Annotations about the sample.
- **Replicate Group**—A set of replicate values organized as a set to facilitate calculation of statistics.
  - **BR AVG**—The average binding rate of the replicate group
  - **BR SD**—The standard deviation of the binding rate of the replicate group
  - **BR CV**—The coefficient of variance of the binding rate of the replicate group
  - **Concentration avg**—The average concentration of the replicate group
  - **Concentration SD**—The standard deviation of the concentration of the replicate group
  - **Concentration CV**—The coefficient of variance of the concentration of the replicate group
- **Sensor Type**—The biosensor chemistry utilized in the assay.
- **Lot Number**—The lot number of the biosensor tray used in the assay
- **Sample**—The well location in the sample plate.
- **Sample ID**—The name of the sample entered in the Octet System Data Acquisition software.
- **Group Type**—The well designation (Standard, Unknown, Reference, or Control).
• **Binding Rate**—The rate of sample binding to the biosensor computed by the Octet System Data Acquisition software using the binding rate equation specified.

• **Known Conc.**—The user-specified standard concentration that was entered during sample plate definition.

• **Calc. Conc.**—The sample concentration computed from the standard curve.

• **Residual (%)**—Residual = (Expected standard concentration—Calculated standard concentration)/Expected standard concentration

• **r² (COD)**—The $r^2$ of the curve fit used to determine the binding rate.

• **Well Information**—User-specified notes about the wells.

**Sample Plate Map**

The *sample plate map* displays well data, and can be used to select which type of results to display. Select the type of results to display in the sample plate map (*Show Table Column* drop-down list). For example, select **Calc. Conc.** to display the computed sample concentrations on the map.

**Results Table**

The *results table* displays detailed results for each well in the plate map.

**Sorting Results Table Entries**

The information in the results table can be sorted in ascending or descending order based on the values in any of the columns:

• To sort the entries in ascending, alphanumeric order, click a column header.

• To sort the entries in descending order, click the column header again.

**Applying Alerts**

**Applying Standard Alerts**

In the Results window, you can select threshold(s) that are applied to the standards. You can also edit the alert threshold value:

• **Min Sample r²**—The threshold $r^2$ value for a standard or unknown binding curve. If the $r^2$ value of a standard or unknown binding curve is less than the threshold value, the standard or unknown sample is highlighted in the results.

• **Max Residual**—Specifies a threshold residual value for standards. If a calculated standard concentration deviates +10% or greater from the expected concentration, the standard is highlighted in the results.

• **Sample Alert**—Specifies highlights data that fit user specified criteria. Thresholds can be set for r2, max residual, or both.

• **Both Min r² and Max Residual**—Applies both the Min Sample r2 and Max Residual thresholds to the data.
• **Do not use alerts**—Select if you do not want to apply any thresholds to the unknown or standard sample data.

To apply a standards alert:

1. In the sample plate map, select the type of data to display data from the drop-down list.
2. Select a type of alert.
   - Samples that do not meet the threshold are highlighted in the sample plate map and results table.
3. Edit an alert threshold value:
   - Select the cell and enter a new value.
   - Right-click the cell to display a shortcut menu of editing commands.
**Applying Sample Alerts**

The Sample Alert highlights data that fit user specified criteria.

To apply sample alerts:

1. Set the thresholds for $r^2$, max residual, or both (Figure 4-22).

![Figure 4-22: Sample Alerts](image)

2. Alternatively, set either a positive or negative threshold on the standard deviation of either the binding rate or the calculated well concentration (Figure 4-23).

![Figure 4-23: Sample Alert Dialog Box](image)

Rows that match criteria specified in the “Sample Alert” are highlighted in the results table of the quantiation experiment (Figure 4-24).

![Figure 4-24: Sample Alert Results](image)
The highlighted rows are marked in the Alert column in the analysis table (Figure 4-25).

![Figure 4-25: Alert Column]

SAVING STANDARDS DATA

After analysis, the standards data can be saved for use with other quantitation experiments; to do so:

1. In the Results tab (see Figure 4-20: on page 61), click Save Standards.
2. In the displayed dialog box, select the file folder and enter a filename (.fsc).
3. Click Save.

SAVING ANALYSIS SETTINGS

To save the analysis settings in the Results and Data Selection windows, click Save Analysis Settings.

A Settings_DataAnalysis file (.ini) is saved in the experiment folder. These settings are displayed the next time the experiment is loaded.

---

**NOTE:** The Settings_DataAnalysis.ini file is also automatically saved when you click Calculate Binding Rate! The Settings_DataAnalysis.ini file may also be used during batch processing.
PROCESSING BATCH QUANTITATION ANALYSIS

In batch mode, multiple quantitation data sets may be processed without attended operation. The Octet System Data Acquisition software analyzes experiment data using the data processing parameters in a designated Settings_DataAnalysis.ini file. The experiments in a batch can be analyzed using the same or different .ini files. The processed data can be saved to either the original data folder or an alternative folder.
Creating a Settings_DataAnalysis.ini File

NOTE: The Settings_DataAnalysis.ini file is also automatically saved when you click Calculate Binding Rate!

To create a Settings_DataAnalysis.ini file:

1. Load and open an experiment that will be included in the batch.
   The Data Selection window displays (Figure 4-26).

![Figure 4-26: Data Selection Window](image)

2. Set the data viewing options (refer to Table 4-1 on page 54).
   The Results window displays (Figure 4-27).
3. Set the analysis options (standard curve equation, processing parameters, standards sample alerts). For more details, see “Analyzing Data” on page 57.

4. Click Save Analysis Settings.
   The .ini file is saved in the experiment folder.

5. Optional. Analyze each experiment using a different .ini file; repeat steps 1–4 to create a .ini file for each experiment in the batch.
Selecting Experiments and Running the Batch Analysis

To select experiments and run the batch analysis:

1. On the menu bar, click File > Quantitation Batch Mode.

   The Quantitation Batch Model dialog box displays (Figure 4-28).

2. Set the batch mode options as follows:
   - Ini File
     - Use the one in each folder—Analyzes each experiment using the .ini file found in the same experiment folder.
     - Use one for all folders—Analyzes all experiments using a user-selected .ini file.
     - Well Information—Specifies a path within the experiment folder to the Settings_WellInfo.xml file. Select only a Well Information file if you modified the original well information by editing (for more information, see “Editing Experiments” on page 46). The Settings_WellInfo.xml file can be found in the experiment folder of an experiment that has been edited in the Octet System Data Acquisition software. Select a well information file if the Use one for all folders option is selected.
   - Output Folder
     - Use the original data folder—Analysis results are saved in the experiment folder.
     - Use this folder—Saves the analysis results to a user-selected folder.

3. Click Add Folders to select the experiments for batch analysis.
4. In the displayed dialog box, select an experiment folder and click Add. Repeat to select each experiment in the batch.

5. Optional. Remove experiments from the batch: select the corresponding folders and click Remove Selected.

6. Click Analyze Data.

EXPORTING DATA

Raw data or quantitation result reports can be exported.

**Saving Raw Data**

To save raw data:

1. In the Results window (Figure 4-21), click Save Raw Data.
2. In the displayed dialog box, select a destination directory.
3. Enter a filename and click Save.

The raw data are saved as a .csv file that can be opened in a spreadsheet application such as Microsoft® Excel® software.

**Saving a Quantitation Results Report**

All information in the results window can be saved to a report. The Octet System Data Acquisition software generates an Excel spreadsheet (.xls file) that includes the current contents of the results window:

- Calibration curve(s)
- Sample plate map that shows the user-selected type of data
- Results table

**NOTE:** If multiple experiments are open, the report will include a separate worksheet for each experiment.
To save a quantitation results report:

1. On the menu bar, click File > Save Report, or click the Save Report button.
   The Report Selection dialog box displays; see Figure 4-30.

   ![Figure 4-30: Report Selection Dialog Box]

2. Select the components from the analysis to be exported, enter a file name and click Save.
   The report is saved to the data folder.
CHAPTER 5:
Basic Kinetics Analysis

Working with Experiments ................................................................. 76
Working with Raw Data ................................................................. 88
Processing Kinetic Data ................................................................. 96
Kinetics Analysis ................................................................. 113
Processing Batch Kinetics Analysis ............................................... 119
Kinetics Analysis Results ............................................................. 123
Working with Graphs ................................................................. 138
Data Export Options ................................................................. 140
Generating a Report ................................................................. 141
WORKING WITH EXPERIMENTS

Starting a Basic Kinetics Experiment

A basic kinetics experiment enables you to determine the association and dissociation rate of a molecular interaction. After an experiment is run, start a data analysis session (double-click the icon on the desktop).

There are several ways to start a basic kinetics experiment:

- Use the Experiment wizard.
- Open a method file (.fmf). An experiment method file (.fmf) is automatically saved after you define and run an experiment.
- On the menu bar, click Experiment > Templates > Kinetics.

NOTE: When using the 21 CFR Part 11 version of the Octet System Data Acquisition software, only 21 CFR Part 11-compliant experiments and re-analyze generated using the 21 CFR Part 11 version of the software can be opened. Files generated using the non-compliant version of the software or with a non-compliant system cannot be opened, and a message indicating this will be presented.

Loading an Experiment for Analysis

A data analysis session can be used to:

- Load and analyze an experiment.
- Re-analyze an experiment.

To load an experiment for analysis:

1. On the desktop, click the icon. Or, click the Windows Start button and select All Programs > ForteBio > ForteBio Data Analysis 7.0.
   
   The Data Selection window displays.

2. Load an experiment:
   
   a. Right-click the experiment folder in the workstation directory tree and select Load Folder; or, on the menu bar, click File > Load a Folder.
   
   b. In the Load Folder dialog box, enter the folder name or click the Browse button and select the desired folder, and then click Load.
   
   The experiment is added to the Loaded Data directory tree (Figure 5-1).
3. In the Loaded Data directory, click an experiment name to open it. The experiment summary appears (Figure 5-2).

NOTE: Multiple kinetics can be loaded, but only one kinetic can be open at a time. The icon in the Loaded Data directory tree indicates the open experiment.
4. Optional. If any step types have been incorrectly assigned in the Octet System Data Acquisition software, change them before beginning analysis. To do so, right-click the step and select the correct step type from the shortcut menu (Figure 5-3).

Figure 5-2: Data Selection Window—Displaying Experiment Summary Information

Experiment information and data files (.frd)
List of all available steps for the assay
Steps performed in the assay
5. In the Sensor Tray tab, confirm the biosensors to be analyzed.

The first group of biosensors is automatically selected for analysis. Biosensors that are assigned to the same type of assay step and have the same assay (step) times are displayed in the same color, providing convenient identification of multiple types of assays executed in one experiment and using one biosensor tray (red in Figure 5-4). Only biosensors of the same color processed simultaneously. This provides a convenient way to identify multiple experiments on a biosensor tray.

6. Select particular biosensors for the analysis:
   a. Click a biosensor. To select non-adjacent biosensors, press and hold the Ctrl key while you click the biosensors.
   b. Select a column(s) or row(s). To select non-adjacent columns or rows, press and hold the Ctrl key while you click the columns or rows.
   c. Draw a box around the biosensors using the mouse.

   The number of biosensors selected for analysis in the current tray will be displayed in the upper-right corner of the Sensor Tray tab.

7. Choose the Ignore error in files option when loading to load data files regardless of whether a runtime error was identified. This enables data visualization even if a sensor error occurred during runtime.

   **NOTE:** Only the selected biosensors will be available in the Processing window.
Analyzing Binding Data

To analyze the binding data:

1. Start an analysis session and select the experiment(s) to use.
   a. Confirm or change the biosensor and sample type selected for the analysis.
   b. Process the data (compile binding curves with or without reference subtraction).

2. Analyze the binding data:
   - Curve fitting analysis—Determines the kinetic constants $k_a$, $k_d$ and the affinity constant $K_D$ from fusing a specified binding model.
   - Steady state analysis—Determines the affinity constant $K_D$ from the calculated or measured equilibrium response.

3. View the results in graphical and tabular formats.

4. Export the results and generate a report.
Editing Experiments

The Octet System Data Acquisition software enables you to change sample designations, standard concentrations, or exclude samples from analysis. For example, you can exclude a standard that does not meet the sample $r^2$ or residual threshold, then re-analyze the data. You can also modify some processing parameters.

Changing Sample Designations

To change sample designations:

1. Click the Data Selection tab, then do either of the following:
   - In the sample plate map, select the well(s), right-click and select an option from the shortcut menu.
   - In the results table, right-click a table cell in the Well Type column, then make a selection from the drop-down menu.

Excluding/Including Samples from Analysis

To toggle sample analysis in the Results window, perform one of the following tasks:

- In the sample plate map, select the well(s), right-click and select Exclude Wells to remove the samples from the analysis. If the selection is already excluded from analysis, select Include Wells to return the samples to the analysis.

- In the results table, to exclude wells, de-select the check box in the first column or right-click selected rows and select Exclude Wells. If the selection is already excluded from analysis, click the check box for the desired rows or right-click desired rows and select Include Wells.
Editing Standard Concentration or Well Information

To edit standard concentration or well information:

1. In the table of either the Data Selection or Result tab (Figure 5-8), right-click and select Edit Sample Information.

The Edit Sample Information dialog box displays (Figure 5-8).
2. Enter the new information in the appropriate fields and click **OK**.

**Editing Processing Parameters**

To edit processing parameters:

1. Modify the following parameters as appropriate:

   - **Read time**—The amount of data that is analyzed.
   - **Zero concentration threshold**—Binding rates that are less than the zero concentration threshold are considered zero.
   - **Low concentration threshold**—When you click **Calculate Binding Rate**!, the raw data are fit using both a linear and an exponential equation. Both sets of fitting data are not reported. The user-specified **low concentration threshold** determines which binding rates are taken from the linear fit and which binding rates are taken from the exponential fit.
     - If the result of the linear fit is below the user-specified **low concentration threshold**, then this value is reported as the binding rate in the results table.
     - If the result of the linear fit is above the user-specified **low concentration threshold**, then the binding rate value obtained from the exponential fit is reported in the binding rate column of the results table.

2. In the Results window, select the cell that you want to edit and enter a new value. Or, right-click the cell to access a shortcut menu of edit commands.

   The modified parameters are saved in the **Settings_DataAnalysis.ini** file and are automatically loaded when the data is analyzed again. If a new data set is loaded, the default parameters are restored.
**Viewing Binding Curves**

To view binding curves, in the sample plate, select a well(s), or in the sample plate table, select a row(s).

To select non-adjacent rows or wells, press and hold the Ctrl key while clicking the wells or rows.
### Viewing Options

**Table 5-1: Viewing Options in the Data Selection Window**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Align X</strong></td>
<td>Choose this option if there is an artifact at the beginning of the binding step that you want to remove. Enter a time (seconds) at which to start the alignment.</td>
</tr>
<tr>
<td><strong>Reference Subtraction Average of</strong></td>
<td>If the experiment includes reference biosensors, choose the Reference Subtraction option and select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• All—Computes the average binding curve from the reference wells and subtracts this average from each sample curve.</td>
</tr>
<tr>
<td></td>
<td>• Row—If a row includes both samples and references, the Octet System Data Acquisition software computes the average reference curve for the row and subtracts this curve from the samples in the same row.</td>
</tr>
<tr>
<td></td>
<td>• Column—If a column includes both samples and references, the Octet System Data Acquisition software computes the average reference curve for the column and subtracts this curve from the samples in the same column.</td>
</tr>
<tr>
<td><strong>Flip Data</strong></td>
<td>The Flip Data function inverts signals from positive to negative or from negative to positive. This is used most often when the observed nm shift is negative due to the presence of large analytes, such as phage, cells, and lipoparticles on the biosensor surface.</td>
</tr>
<tr>
<td><strong>Grouped View</strong></td>
<td>Displays graphs in custom groupings. Choose this option to display graphs organized into groups according to sample attribute or results category. This is a highly useful feature when working with large data sets.</td>
</tr>
<tr>
<td></td>
<td>• Options—Click to show the Grouped View Options dialog box.</td>
</tr>
<tr>
<td></td>
<td>• Refresh—Updates the graph display.</td>
</tr>
<tr>
<td><strong>Ignore errors in files when loading</strong></td>
<td>If this option is chosen, the Octet System Data Acquisition software ignores errors in data files. All data files, regardless of errors or runtime issues, will be loaded for analysis.</td>
</tr>
<tr>
<td><strong>Show All Traces</strong></td>
<td>Displays all binding curves.</td>
</tr>
<tr>
<td><strong>Edit Legends</strong></td>
<td>Select the sample information displayed in the legend. Options include Sensor, Sample, Sample ID, Group, and Concentration.</td>
</tr>
</tbody>
</table>
**Opening Binding Curve in Separate Window**
To open the binding curve chart in a separate window, double-click the graph.

**Customizing Appearance of Graph or Binding Curve**
To customize the appearance of the graph or a binding curve; see Figure 5-11. Right-click the graph or a curve for a shortcut menu of display options.

- Hover over a binding curve to display a tooltip of the XY coordinates.
- Right-click the graph to view a shortcut menu of display options.
- Right-click a curve to view a shortcut menu of display options.
- Right-click the graph and select **Toolbar**. Toolbar buttons enable you to save, copy, or print the graph.

*Figure 5-11: Viewing Binding Curves*
**Closing Experiments**

To close an experiment, in the Loaded Data directory tree, right-click the experiment name and select Remove Run (see left side of Figure 5-12).

To close all experiments in the Kinetics or Quantitation folder, right-click the folder and select Remove All (see right side of Figure 5-12).

![Figure 5-12: Closing a Kinetics Experiment](image-url)
WORKING WITH RAW DATA

Viewing Raw Data

In the Processing window, the Raw Data view enables you to conveniently examine the binding data.

To view raw data:

1. In the Processing window, the Processing tab and confirm that the Raw Data View option is selected.
2. View the step data and align the binding curves (click a step bounded by lines in the Raw Data chart).

![Diagram showingRaw data from all steps (displays all biosensors by default) and Raw data from selected step (displays all biosensor data for the selected step by default)](image)

Figure 5-14: Processing Window—Raw Data View Selected

**NOTE:** The lines represent individual assay steps. Populate the step charts (below) with detailed views of an individual step by clicking inside the step boundaries.

The “All Steps Aligned by step xx” chart displays all of the assay data aligned by the step selected in the Raw Data chart (Figure 5-15).
3. Select which biosensor data to display:
   - To view the data from a selected biosensor, click the biosensor in the table. The step charts will display all of the binding data for the selected biosensor and the data from the selected step aligned starting at $y = 0$.
   - To display data from multiple biosensors in the step charts, select the biosensors in the Sensor location list.
   - To select a contiguous block of biosensors from the list, hold down the Shift key and click the first and last biosensors in the group.
   - To select non-contiguous biosensors, hold down the Ctrl key and click the desired biosensors.
   - To include all biosensor data in the step charts, click Show All Sensors.
4. Align the data (select an alignment option):
   - **Show All Steps Aligned**—Aligns all steps. Aligns baseline steps and association steps to the start of the step. Aligns all dissociation steps to the end of the step.
   - **All Aligned to One Step**—Enables the following options:
     - **Align by Begin Point**—Aligns the displayed curves to the start of the currently-selected step.
     - **Align by End Point**—Aligns the displayed curves to the end of the currently-selected step.
   - **Align All Baselines**—Aligns all steps according to the baseline step data.

**Exporting Raw Data**

To export raw data:

1. Click **Export Aligned Step (.csv files)**.
2. In the displayed dialog box, navigate to a destination directory, enter a filename, and click **Save**.

**Quantititating Raw Data**

To quantitate raw data from a selected step:

1. In the Raw Data view, select the step to quantitate and click **Quantitate Selected Step** (Figure 5-17).
2. In the system prompt that displays, click Yes to proceed with the quantitation. The selected step data is displayed in a quantitation window (Figure 5-18). By default, samples are designated as unknowns.

For more details on viewing the quantitation data, see “Viewing Binding Curves” on page 84.

![Figure 5-17: Processing Window—Raw Data View—Quantitating a Selected Step](image_url)
3. Optional. Change the sample type:
   a. Select wells in the sample plate map or sample rows in the table.
   b. Right-click the selection in the plate map or table and select a sample type.

**NOTE:** When step data from a kinetic assay is open, additional quantitation experiments cannot be opened.
4. Set a standard concentration value: in the sample table, double-click the Conc. cell and enter a value (Figure 5-20). (To access a shortcut menu of editing commands, right-click the cell.)
5. In the Results window, select a standard curve equation, set the processing parameters, and then click Calculate Binding Rate!

The binding rates will be calculated and displayed; see Figure 5-21.

For more details on analyzing quantitation data, see “Loading an Experiment for Analysis” on page 76.
Chapter 5: Basic Kinetics Analysis

NOTE: To return to kinetics analysis mode, reload the kinetics experiment data (in the Loaded Data directory tree, click the experiment).

PROCESSING KINETIC DATA

The Processing window provides tools for correcting binding curves using different reference subtraction and alignment options. The data processing steps specify how to reference the data and produce the final binding curves (processed data).

Step 1: Sensor Selection

When a kinetics experiment is opened for the first time, the sensor tray map depicts all active biosensors as ligand biosensors (biosensors with immobilized ligand). If the experiment included reference biosensors (biosensors without immobilized ligand), you must specify their location in the sensor tray map. If the experiment included reference buffer wells (to correct for system drift), you must specify their location in the sample plate map.
**Working with the Sample Tray Map and Sensor Tray Map**

To use the sample tray map and the sensor trap map (Figure 5-22):

1. Hover the cursor over a biosensor or sample to display a tooltip with information about the item.
2. Click a biosensor or sample to highlight the associated row in the corresponding table at the bottom of the window.
3. Optional. Copy the sensor tray map or sample plate map to the system clipboard, right-click the map and select **Copy to Clipboard**.
   
   The clipboard contents can be saved as a graphic file for drawing applications.

**Selecting Biosensors**

To select biosensors:

1. In the **Step 1: Data Selection** pane, select the **Sensor Selection** option (Figure 5-22).

   ![Figure 5-22: Selecting Biosensors in the Processing Window](image)

2. Specify reference biosensors:
   a. In the sensor trap map, select the appropriate biosensors.
   b. Right-click and select **Change Sensor Type > Reference Sensor** (Figure 5-23).
Figure 5-23: Changing the Biosensor Type

NOTE: The biosensor designations can also be edited in the sensor tray table (Figure 5-22: on page 97).

3. Specify reference wells:
   a. In the sample plate map, select the appropriate wells.
   b. Right-click and select Change Well Type > Reference Well (Figure 5-24).
4. Exclude wells from analysis:
   a. In the sample plate map, select the wells.
   b. Right-click and select Exclude Wells for Analysis (Figure 5-24).

**Step 2: Reference Subtraction**

Reference subtraction is optional and is not required for all applications. There are two types of references used in Octet experiments: reference biosensors and reference wells.

- **Reference biosensors**—Used as a references throughout the entire assay; for example, biosensors without active capture molecules.
- **Reference wells**—Contain only assay buffer, and are used to measure system drift.

To apply reference subtraction during data processing:

1. In the **Step 2: Subtraction** pane, select the **Subtraction** method.

   The subtractions that will be executed (based on the subtraction method, biosensor designation and sample plate well designation) are listed in the **Sensors to be Analyzed** box.

   If the subtraction method is not compatible with the sensor tray map and the sample plate map, a question mark is displayed in the **Sensors to be Analyzed** box.

2. Confirm the biosensor subtraction in the **Sensors to be Analyzed** box.
If an experiment includes reference biosensors and reference wells, the Octet System Data Acquisition software offers multiple reference subtraction methods for data processing:

- **Reference Wells**—Corrects binding data for system drift. For example, drift is measured by the interaction of the immobilized biosensors with the assay buffer. This method requires at least one row of reference wells in the sample plate. If more than one row of reference wells is selected (checked), the signals are averaged and the average signal is subtracted from the samples.
• Parallel Reference Sensors—Corrects data for system artifacts or non-specific binding of the sample to the biosensor surface. This method requires one reference biosensor for each ligand biosensor.

Figure 5-26: Reference Wells—Subtraction Method where Biosensor H1 is the Reference
**Figure 5-27: Parallel Reference Sensor—Reference Subtraction Method**

- **Double Reference**—Corrects the binding data for signal due to system artifacts, non-specific binding, and system drift. This method requires one reference biosensor per ligand biosensor and one or more rows of reference buffer in the sample plate.
**NOTE:** In Figure 5-28, A1–A3=Target biosensor A1 corrected by reference biosensor A3, both probing reference wells B1–B3=Target biosensor B1 corrected by reference biosensor B3 for biosensor and microplate well artifacts, both probing positive sample. (B1–B3)–(A1–A3)=Double reference subtraction fully corrects for biosensor and microplate well artifacts and the effect of sample media.

- **Average Reference Sensors**—Corrects the binding data using either a single reference biosensor or the average signal of multiple biosensors.
In Figure 5-29, $A_{B1} - (A_1 + A_2 + A_3 + A_4)/4 = \text{Target biosensor B1 corrected for sample medium interference by the average of all reference biosensors.}$

**Step 3: Align Y Axis**

In order to fit curves correctly, they must be aligned to a common reference point upon both the X and Y axes:

- Alignment along the X axis is achieved during assay due to the parallel movement of all biosensors.
- Alignment along the Y axis is achieved using Align Y Axis by specifying both a step and time with which to execute the alignment.

The time range from the specified step will be used to calculate an average and that average will then be set to $y=0$. For example, for alignment to the baseline, select baseline and specify the time within the baseline step to set to an average $y=0$.

To align to association:

1. Select the Align Y Axis option and make a selection from the Step drop-down list.
2. Confirm the time range defaults or enter new start and finish times. If you choose to align to the association step, set the shortest time range possible at the beginning of the association step to align $Y=0$. 
**Step 4: Interstep Correction**

The interstep correction feature corrects misalignment between two steps due to system artifacts. The association step can be aligned to the dissociation step or to the baseline.

*IMPORTANT:* For the most effective interstep correction, the baseline and dissociation steps of an assay cycle must be performed in the same microplate well.

- **Align to Dissociation**—Moves the association step on the Y axis to align the end of the association step with the beginning of the adjacent dissociation step.
- **Align to Baseline**—Moves the association step on the Y axis to align the beginning of the association step with the end of the adjacent baseline step.

*NOTE:* Interstep correction is not recommended for very fast kinetics because some kinetic information may be lost.
**Step 5: Process**

Savitzky-Golay filtering removes high-frequency noise from the data. Its use is optional, but is recommended unless the data being analyzed has less than 20 data points in a step.

To process the data (select and confirm the biosensors to analyze):

1. Apply Savitzky-Golay filtering by clicking the Savitzky-Golay Filtering check box; see Figure 5-31.

   ![Figure 5-31: Selecting and Confirming the Biosensors to Analyze](image)

2. Click **Process Data**.

   The processed binding curves are displayed with "Raw", "Align-Y" and "Align-" windows. The processing parameters are automatically saved to the *Settings_DataAnalysis.ini* file in the data folder.

   The processing parameters may also be saved by clicking **Save Proc. Parameters**. These processing settings are displayed the next time the experiment is loaded.

   The processed results (Figure 5-32) include:
   - **Raw Data**—Binding curves with no reference subtraction.
   - **Subtracted Data**—Binding curves after the user-specified reference subtraction method is applied.
   - **Align Y**—Binding curves after user-specified Y alignment.
   - **Align X**—Binding curve association steps aligned at the same time point.
3. Click Save Proc. Parameters to save the process settings. A Settings_DataAnalysis.ini file (.ini) is saved in the experiment folder. These processing settings are displayed the next time the experiment is loaded.

**Step 6: Viewing Results**

The Octet System Data Acquisition software provides multiple display options (Figure 5-33) for processed data:

- “Processed Results” on page 108
- Sensor Summary
- Report Points
Processed Results

- Double-click a graph to display it in a separate window (Figure 5-34).
- Hover the cursor over a curve to highlight the curve and display a tooltip of the time (X axis) and nmshift (Y axis) at that point (Figure 5-34).
- Customize the graph by right-clicking the graph for a shortcut menu of display options (Figure 5-35).
- Customize the curve display, right-click the curve for a shortcut menu of display options (Figure 5-35).

NOTE: The same display options are also available for binding charts in the Fitting and Residual views in the Analysis tab.

Figure 5-34: Double-click a Binding Chart to View it in a Separate Window
Sensor Summary

The Sensor Summary view displays the binding charts generated during data processing (Figure 5-36).

The Sensor Summary view controls enable you to select the sensor data to display:

- Hover over a binding curve displays a tooltip with sample data.
- Click a sensor tab or one of the arrow buttons in the Sensorgrams controls at the bottom of the window to view data for a specific biosensor.
- Set the number of sensorgrams per row and the number of rows to display.
- Use the Top View check boxes to show or hide the raw data and subtraction graphs in the top row.
NOTE: In Figure 5-36, the data were processed using the Reference Well subtraction method.

Report Points
The Report Points view displays the raw binding data in tabular format (Figure 5-37). Report point analysis can also be performed in the Analysis window; the data will be added to the Report Point Analysis table.

NOTE: Click a sensor tab at the bottom of the binding chart to view data for a particular biosensor.
Report Point Analysis Features

- **Input times after beginning of Association Step**—The Octet System Data Acquisition software measures the sample binding (nm shift) at Time 1 (within the association step) and Time 2 (within the dissociation step). Both time points refer to time in seconds after the beginning of the association step. You can edit Time 1 or Time 2.

- **Use 20 point average**—Each reported nm shift in the table represents an average of 20 data points centered around the time point specified.

- **Apply**—If you modify Time 1 or Time 2, click Apply to re-analyze the sample binding of the active ligand biosensor at the new time points. Report points can also be determined in the Analysis window.

- **Apply All**—If you modify Time 1 or Time 2, click Apply All to re-analyze the sample binding of all ligand biosensors at the new time points.

- **Export File (.txt)**—Opens a Save As dialog box so that you can save the Report Point Analysis table.

Results Information

- **Sensor Location**—Ligand biosensor location.

- **Sample Location**—The well location of the sample in the sample plate.

- **Sample ID**—User-specified ligand biosensor information.
• Concentration (mM)—Sample concentration.
• Time 1 (sec)—Time at which the first binding measurement is acquired.
• Binding 1 (nm shift)—The binding signal at Time 1.
• Time 2 (sec)—Time at which the second binding measurement is acquired.
• Binding 2 (nm shift)—The binding signal at Time 2.

Step 7: Saving Results and/or Processing Parameters

In this step, you can save the following parameters:

• Raw data
  • X,Y data for the curves in the final Processed Results graph to a file format that can be imported to third party applications like Scrubber2 from BioLogic Software.
  • Processing parameter settings. The processing parameters are set to the saved values the next time the experiment is loaded.
• Binding chart

To save the processed data:
1. Click Save Processed Data (Figure 5-38).
2. In the displayed dialog box, select a destination folder and click OK.
   The Octet System Data Acquisition software generates a separate file (.xls) for each biosensor that includes the time, nm shift and sample concentration for each processed curve. This file is suitable for import into third party applications.

To save the raw data:
1. Click Save Raw Data (Figure 5-38).
2. In the displayed dialog box, select a destination folder and click OK.
   The Octet System Data Acquisition software generates one file (.xls) that includes time and nm shift data for all of the biosensors.

To save the processing parameters:
1. Click Save Proc. Parameters (Figure 5-38).
   The processing parameter values are saved as an .ini file in the experiment folder.

Figure 5-38: Save Results Options
To print or copy a binding chart:

1. Right-click the chart and select Toolbar (Figure 5-39) to access the printing and copying buttons (the buttons will appear at the upper left of the binding chart).

![Binding Chart Shortcut Menu](image)

*Figure 5-39: Binding Chart Shortcut Menu*

2. Select the desired command:
   - ![Open a dialog box that enables you to save the chart in several different formats](image)
   - ![Open a dialog box that enables you to copy the chart in several different formats](image)
   - ![Open a dialog box that enables you to print the chart](image)

**KINETICS ANALYSIS**

In the Analysis window, two types of kinetics analysis are available:

- **Curve fitting**—Determines the kinetic constants $k_a$, $k_d$ and the affinity constant $K_D$ by fitting the data to a specified binding model.
- **Steady state analysis**—Determines the affinity constant $K_D$ from the calculated or measured equilibrium response.
Curve Fitting Analysis

To analyze the processed kinetic data, specify the curve fitting options:

- Steps to analyze
- Curve fitting model
- Type of fitting (local or global) to apply to the data
- Step time to analyze

Curve Fitting Kinetics Analysis Options

- **Steps to Analyze**—Select the step(s) to include in the analysis: association, dissociation, or both.
  - Association only—Generates $k_{\text{obs}}$.
  - Dissociation only—Generates $k_{\text{dis}}$.
  - Association & dissociation—Generates $k_{\text{obs}}, k_{\text{on}}, k_{\text{dis}},$ and $K_D$.
- **Model**—The mathematical model that is used to generated the fitted view.
  - 1:1 Model—Fits one analyte in solution binding to one binding site on the surface
  - 2:1 (HL) Model—Fits the binding of one analyte in solution to two different binding sites on the surface. Kinetic parameters are calculated for two interactions ($k_{\text{on}1}, k_{\text{on}2}, k_{\text{dis}1}, k_{\text{dis}2}, K_{D1}, K_{D2}$).
  - 1:2 Bivalent Analyte Model—Fits the binding of one bivalent analyte to a monomeric immobilized ligand. Kinetic parameters are calculated for two interactions ($k_{\text{on}1}, k_{\text{on}2}, k_{\text{dis}1}, k_{\text{dis}2}, K_{D1}, K_{D2}$). The model is available in the Analysis tab—Model menu—in Kinetics mode.
  - Mass Transport—A Heterogeneous Ligand model that fits the binding of the analyte taking into account two steps: 1) transport of the analyte from the bulk solution to the surface, and 2) molecular interaction of the analyte with the ligand.
- **Fitting-Local**—If this option is selected, the Octet System Data Acquisition software computes kinetic constants for each curve. The constants that are calculated depend on the steps that are analyzed (association only, dissociation only, or association and dissociation).
  - Full—If this option is selected, the Octet System Data Acquisition software assumes that the off rate eventually reaches the pre-association baseline and forces the curve fit to that point.
  - Partial—If this option is selected, the Octet System Data Acquisition software does not assume the dissociation will reach the pre-association baseline.
- **Fitting-Global (Full)**—If this option is chosen, an analysis includes all of the binding curve data in the group and the Octet System Data Acquisition software generates kinetic constants for the entire group. The kinetic constants that are calculated depend on the model selected.
• **By Sensor**—Groups all data from one biosensor (for example, Biosensor A1) together and applies a global fit to the group.

• **By Color**—Groups all data that is the same color and applies a global fit to that group. For more details on defining colors by sample attributes, see “Working with the Analysis Results Table” on page 131.

• **Rmax Unlinked option for Global Fitting**—When fitting data, the theoretical *response maximum* (Rmax) can be calculated assuming equivalent surface capacity between biosensors (Rmax linked) or non-equivalent surface capacity between biosensors (Rmax unlinked).

• **Window of Interest (From Start of Step)**
  - **Association**—The time range of the association step data to analyze.
  - **Dissociation**—The time range of the dissociation step data to analyze.
  - **Use Entire Step Times**—Analyzes the entire time duration of the selected step(s).

*Figure 5-40: Analysis Window*
Excluding Data from Analysis

To exclude data from the analysis:

1. In the table:
   a. Select the biosensor data (rows) to exclude:
      - To select adjacent rows, hold down the Shift key while you click the first and last row in the selection.
      - To select non-adjacent rows, hold down the Ctrl key while you click the rows.
   b. Right-click the selected row(s), and select Exclude Wells (Figure 5-41) or press the space bar. Press the space bar again to toggle the include/exclude status of the curve.

   Biosensors that will be included in the analysis have an “X” in the Include column; excluded biosensors do not (Figure 5-41).

2. Click Fit Curves!

   The analysis results are displayed; data from wells marked for exclusion will not be included (Figure 5-42).
3. Save the settings in the Analysis window: click Save Data Analysis Parameters (Figure 5-43).

A Settings_DataAnalysis.ini file is saved in the experiment folder. These settings are displayed the next time the experiment is loaded.

**NOTE:** The Settings_DataAnalysis.ini file is also automatically saved when you click Fit Curves!
Steady State Analysis

To analyze the processed kinetic data:

1. Set the analysis options (for more details, see Table 5-1 on page 85).
2. Click Calculate Response! to display the analysis results. For more information on viewing results, see “Kinetics Analysis Results” on page 123.

Excluding Data from the Analysis

To exclude specific data from the analysis, remove the check mark next to the row in the analysis results table. Or, right-click the selected row(s) and select Exclude Wells.

Steady State Kinetics Analysis Options

- **R equilibrium**—Fits the binding curve to a 1:1 model and uses the calculated Req to determine the steady state affinity. If this option is selected, you first must perform a curve fitting kinetic analysis.
- **Response**—Takes the average response from the user-specified time window and uses it to calculated the steady state affinity.
• **Average from**—The of amount of equilibrium state data to analyze, from the time equilibrium was reached to the time at which the response should be calculated.

**PROCESSING BATCH KINETICS ANALYSIS**

In batch mode, multiple kinetic data sets may be processed without attended operation. The Octet System Data Acquisition software analyzes experiment data using the data processing parameters in the *Settings_DataAnalysis.ini* file. Batch mode processing may be performed using either a single or multiple .ini files.

During batch processing, sample well and sensor information may be substituted with new text, a useful feature if the naming convention requires editing after data acquisition.

- Sample Well information, which includes Well Type, Sample ID, Description and Molar concentration, can be replaced during batch processing by specifying a *Settings_WellInfo.xml* file during batch processing.
- Sensor information as well as some sample information, which includes Sensor Type, Sensor Info, Sample ID and Molar Concentration can be replaced by specifying a *Settings_TableInfo.xml* file during batch processing.
- If both *Settings_WellInfo.xml* and *Settings_TableInfo.xml* are specified, then the Sample ID and Molar Concentration values from *Settings_TableInfo.xml* are used during batch processing while the corresponding information from *Settings_TableInfo.xml* is ignored.

**Creating a Kinetic Settings_DataAnalysis.ini File**

To create a kinetic *Settings_DataAnalysis.ini* file:

1. Load and open a kinetic experiment that will be included in the batch process.
2. Click the Processing tab.
3. Enter processing parameters. (For more details see “Processing Kinetic Data” on page 96).
4. Click Process Data!.
5. Click the Analysis tab.

   This creates a *Settings_DataAnalysis.xml* file in the experiment folder.

---

**NOTE:** To batch process data sets with individual .ini files, create an .ini file for each experiment in the batch.
Creating a Kinetic Settings_WellInfo.xml File (Optional)

To create a kinetic Settings_WellInfo.xml file:
1. Load and open a kinetic experiment that will be included in the batch process.
2. Click the Processing tab and select Sensor Selection.
3. In the sample plate map, right-click a well and select Edit Sample Properties.
4. Enter the new information for Well Type, Sample ID, Description and Molar Concentration, and then close the dialog box.
5. Click Process Data! or Save Proc. Parameters.
   The Settings_WellInfo.xml file is saved to the experiment folder.

Creating a Kinetic Settings_TableInfo.xml File (Optional)

To create a kinetic Settings_TableInfo.xml file:
1. Load and open a kinetic experiment that will be included in the batch process.
2. Click the Processing tab.
3. Enter processing parameters.
4. Click Process Data!
5. Click the Analysis tab.
   The Settings_TableInfo.xml file is saved to the experiment folder.

**NOTE:** If there is an existing Settings_TableInfo.xml file in the experiment folder, it will be overwritten. The original Settings_TableInfo.xml file that contained information entered during data acquisition is deleted.

6. Right-click the analysis table and select Edit Sample/Sensor Information.
7. Enter the new information for Sensor Type, Sensor Info, Sample Info and Molar Concentration, and then close the dialog box.
   The Settings_TableInfo.xml file is saved to the experiment folder.
Selecting Experiments and Running the Batch Analysis

To select experiments and run the batch analysis:

1. Select File > Kinetic Batch Mode.

   The Quantitation Batch Mode dialog box displays (Figure 5-44).

   ![Kinetics Batch Mode—Quantitation Batch Mode Dialog Box](image)

   Figure 5-44: Kinetics Batch Mode—Quantitation Batch Mode Dialog Box

2. Set the batch mode options:

   • **Use the one in each folder**—Analyzes each experiment using the .ini file found in the same experiment folder.

   • **Use one for all folders**—Analyzes all experiments using a single .ini file that is selected by the user.

   • **Well Information**—Specifies a Settings_WellInfo.xml file in the experiment folder that contains four types of sample information:
     - Well Type
     - Sample ID
     - Description
     - Molar Concentration

   This feature can be used to edit sample information after data acquisition. It is useful, for example, if naming conventions (within a project) change over time and the sample information used during data acquisition requires updating.
• Select a Well Information file only if you edited an experiment in data analysis. For more information about editing an experiment, see “Editing Experiments” on page 46. A Settings_WellInfo.xml file will be put in the experiment folder of any experiment that has been edited in the Octet System Data Acquisition software.

• Select a well information file if the Use one for all folders option is selected. If no .xml file is specified, the well information from the original data acquisition file will be utilized.

• Table Information—Specifies a Settings_TableInfo.xml file in the experiment folder that contains four types of sensor/sample information:
  • Sensor Type
  • Sensor Info
  • Sample ID
  • Molar Concentration

This feature can be used to edit sensor/sample information after data acquisition. It is useful, for example, if naming conventions (within a project) change over time and the sample information used during data acquisition requires updating or if the original plate assignment was incorrect. A Settings_TableInfo.xml file will be found in the experiment folder of any experiment after the data has been processed (in the Processing tab of the Octet System Data Acquisition software) and the Analysis tab has been activated. The Settings_TableInfo.xml file is updated after closing the Edit Sensor/Sample Information dialog box (of the Analysis tab). If no .xml file is specified, the well information from the original data acquisition file is used.

3. Select the experiments for batch analysis:
   a. Click Add Folders.
   b. In the displayed dialog box, select an experiment folder and click Add. Repeat to select each experiment in the batch.
   c. Optional. To remove an experiment(s) from the batch, select the folder(s) and click Remove Selected.

4. Click Analyze Data.
KINETICS ANALYSIS RESULTS

Kinetics analysis results (Figure 5-45) are presented in graphical and tabular formats. Some viewing options in the Analysis window do not require data fitting (analysis) and are available for processed data.

![Analysis Window with Sample Curve Fitting Results](image)

**Figure 5-45: Analysis Window with Sample Curve Fitting Results**

**Fitting View and Residual View**

When the analysis is completed, the fitting view displays the processed binding data and the fitted binding curve (red) for all analyzed biosensors (Figure 5-46). The residual view displays the difference between the raw binding data and the fitted curve for all analyzed biosensors. For more details on graph options, see “Working with Graphs” on page 138.
Figure 5-46: Fitting View and Residual View—Stacked Option

NOTE: In Figure 5-46, a local, full fitting analysis was applied to the data. (For detailed information on graph display options, see “Step 6: Viewing Results” on page 107.)

Fitting view options:

- **Stacked**—Displays the binding curves of all ligand biosensors in one graph (Figure 5-46).
- **Individual**—Displays the binding curve from each biosensor in a separate graph (Figure 5-47).
- **Grouped**—Displays graphs organized into groups according to sample attribute or results category. This is a highly useful feature when working with large data sets.
  - **Options**—Click to display the Grouped View Options dialog box.
  - **Refresh**—Updates the graph display.
- **Y Axis Scaling**
  - **Auto Scale**—Scales the y axis to the data in each graph.
  - **Full Scale**—Scales the y axis to in all graphs to the range needed to accommodate all of the data.
- **Report Points**
  - **Time (sec)**—A user-specified time point in the experiment. The Octet System Data Acquisition software computes the response at that time point.
• **Use Point Average**—Each data point represents an average of the number of data points specified centered around the time point chosen.
• **Add to Table**—Adds the response computed for the user-specified time point to the analysis results table. Up to 10 response points can be added to the table.
• **Remove All**—Removes all of the response data for user-specified time points from the analysis results table.

![Image of Fitting View and Residual View](image)

*Figure 5-47: Fitting View and Residual View—Individual Option*

**NOTE:** The data for all biosensors and samples is displayed.
Grouping Results for Viewing

To group results for viewing:

1. Select the Grouped option and click Options to display the Grouped View Options dialog box (Figure 5-48)

![Grouped View Options Dialog Box](image)

2. From the drop-down lists, select up to three categories for grouping.

The following Grouped view options are available:

- **Group Graphs By**—Select up to three categories for grouping the data across three independent parameters.
- **Legend by**—Select up to two categories to include in the graph legends (Figure 5-49).
- **Additional Graphs**—Select other graphs to display with the analyzed (fitted) data.
- **Data Options**—Click the Use “Included” Traces Only check box to graph only the biosensors that are included in the analysis (marked with an “X” in the analysis results table.
- **Graph Size in Pixels**—Options for graph size and the number of graphs to display per row.
- **Graph Options**—Options for graph labels and other graph display features.
The following options are available for selecting data for viewing:

- To view specific biosensor data, select the rows in the analysis results table.
- To select adjacent rows, hold down the Shift key while you click the first and last row in the selection.
- To select non-adjacent rows, hold down the Ctrl key while you click the rows of interest. The Fitting view, Residual view, and graphs (X-Y, iso-affinity, and steady state) are updated after each data selection.

After a kinetics analysis is completed, the default Fitting and Residual views display the data for all biosensors and samples.
Figure 5-50: Selecting Analysis Results for Viewing in the Fitting View and Residual View
Analysis Results Table

Each row in the Analysis Results table displays the results for one set of association/dissociation data. By default, the Fitting and Residual views include all of the results in the table.

Kinetic analysis results:

- **Index**—Numbered order of the curves processed. The index is useful to sort back to the original order. It is also useful in the graphing applications in the lower right window pane.
- **Include**—“X” indicates data included in the analysis. If this field is blank, the data is not included in the analysis.
- **Color**—The color of the biosensor binding curve in the Fitting and Residual view.
- **Sensor Location**—Location of the biosensor in the sensor tray map.
- **Sensor Type**—The type of biosensor chemistry.
- **Sensor Info**—Information about the biosensor that was entered in the Octet System Data Acquisition software.
- **Baseline Loc.**—Well location in the sample plate or reagent plate (Octet 384 instruments only) in which the baseline was performed.
- **Assoc. (Sample) Loc.**—Sample well location in the sample plate.
- **Sample ID**—The sample ID entered during assay setup.
- **Dissoc. Loc.**—Well location in the sample plate or reagent plate (Octet 384 instruments only) where the dissociation was performed.
- **Conc (nM)**—The molar concentration of the sample used in the association step. The molar concentration is entered by the user or computed by the molarity calculator during experiment setup.
- **Response**—Response calculated from the time window entered in the Steady State Analysis section.
- **KD (M)**—Affinity constant. For the 2:1 and 1:2 models, the Octet System Data Acquisition software computes two $K_D$ values.
- **kon (1/Ms)**—Rate of association. For the 2:1 and 1:2 models, the Octet System Data Acquisition software computes two $k_{on}$ values.
- **kon Error**—Standard error of the rate of association.
- **kdis (1/s)**—Rate of dissociation. For the 2:1 and 1:2 models, the Octet System Data Acquisition software computes two $k_{dis}$ values.
- **kdis Error**—Standard error of the rate of dissociation.
- **Rmax**—The maximum response determined from the fit of the binding data.
- **Rmax Error**—The standard error of Rmax. For the 2:1 and 1:2 models, the Octet System Data Acquisition software computes two Rmax values.
• **kobs (1/s)**—Observed binding rate. For the 2:1 and 1:2 models, the Octet System Data Acquisition software computes two *k*<sub>obs</sub> values.

• **km**—The mass transport rate constant.

• **km error**—The standard error of the mass transport rate constant.

• **Req**—The calculated response at equilibrium that is determined from a fit of the binding data.

• **Req/Rmax(%)**—Ratio of Req to Rmax.

• **Full X2**—A measure of the goodness of curve fitting (not directly related to a parameter estimate). It is the sum of squared deviations, where *deviation* is the difference between the actual data point and the fitted curve. There is one value for each curve-fit. Values close to zero indicate a good curve fit.

• **Full R2**—R² is the coefficient of determination (COD). It is an estimate of the goodness of the curve fit and is not directly related to the estimate of a specific parameter. Values close to 1.0 indicate a good curve fit.

• **Report point #1–10**—Up to 10 report points can be added to the analysis results table using the Report Points feature in the Analysis window. The column heading of each report point is time value used to generate that report point. For example, if a report point is generated at 100 seconds, the column heading is "X=100".

• **SSG K<sub>D</sub>**—The steady state group K<sub>D</sub> value. Use this feature to quickly view the steady state derived K<sub>D</sub> values of groups defined within grouped view (not replicate groups). The column is populated by opening Grouped view, selecting up to three grouping parameter and activating Steady-State under additional graphs. The SSG K<sub>D</sub> value is reported for the set of data within each pane of the Grouped view. Replicate grouping and global analysis are not used to determine this value.

• **SSG Rmax**—The steady state group Rmax value. Use this feature to quickly view the Rmax value of steady state data for a group defined within Grouped view (not replicate groups). The column is populated by opening Grouped view, selecting up to three grouping parameter and activating Steady-State under additional graphs. The SSG Rmax value is reported for the set of data within each pane of the Grouped view. Replicate grouping and global analysis are not used to determine this value.

• **SSG R^2**—The steady state group R^2 value. Use this feature to quickly view the R^2 value of steady state data for a group defined within Grouped view (not replicate groups). The column is populated by opening Grouped view, selecting up to three grouping parameter and activating Steady-State under additional graphs. The SSG R^2 value is reported for the set of data within each pane of the Grouped view. Replicate grouping and global analysis are not used to determine this value.

• **Loading Well Location**—Location of the sample well used during the load step of the experiment.

• **Cycle**—Number of biosensor regeneration cycles.
Working with the Analysis Results Table

To view a shortcut menu of display options (Figure 5-51), right-click the Analysis Results table.

![Figure 5-51: Analysis Results Table Shortcut Menu](image)

Analysis results table display options:

- **Advanced Search**—Searches the contents of the results table of the Analysis tab. Multiple levels and operators are available. Searches may be combined (using AND/OR operator) and saved (see Figure 5-52).

- **Set Color**—Opens the color palette that enables you to choose a color for the selected results (see Figure 5-53).

- **Set Color By Group**—Color-codes the results according to the groups set in the Grouped View Options dialog box (see Figure 5-48).

- **Set Color By**—Enables you to color-code results according to a user-selected category from the analysis results table (see Figure 5-54).

- **Include Wells**—Removes the “X” in the Include column for the selected biosensors. Re-run the analysis to include these biosensors in the analysis.

- **Exclude Wells**—Adds an “X” in the Include column for the selected biosensors. Re-run the analysis to exclude these biosensors from the analysis.

- **Size Columns by Title**—Automatically sets the column width to fit the column title.
- **Size Columns by Data**—Automatically sets the column width to fit the data.
- **Select All Rows**—Selects all biosensors in the table and displays the data in the Fitting view and graphs.
- **Invert Selection**—Changes the wells status so that included wells become excluded wells and excluded wells become included wells. You must re-run the analysis to apply the inverted settings.
- **Order Columns**—Opens a dialog box that enables you to change the order of the table columns.

### Searching Analysis Results

The complete contents of the Analysis tab—results table is searchable using the Advanced Search tool. The search result is a highlighted set of table rows that meet the specified search criteria. The set of rows selected before activation of the Advanced Search dialog box may be combined with the results of the search using ALL, AND, and OR operators specified within the Advanced Search dialog box.

---

**Figure 5-52: Advanced Search Dialog Box**

Advanced Search options:
- **Column**—The column of the results table searched.
- **Operator**—The method of matching the search term with the searchable text. Options include Starts with, Ends with, Contains, Does not contain, and Is empty.
- **Value**—The search term for a single level.
- **Add Level**—Adds one additional search level to the search. The AND operator applies to all levels.
• **Remove Level**—Removes the selected search level.
• **Case Sensitive**—Requires that the case of all characters (uppercase and lowercase) of the search results match the search term.
• **Include Excluded Traces**—Includes all data acquisition traces within the search regardless of exclusion during analysis.
• **Treat Empty Cells as Match**—Returns empty cells of the column as positive matches, useful for searches in which cells were inadvertently left empty during plate assignment or sample annotation.

**Search Options**
• **Search All**—Specifies all text within the Analysis table as searchable regardless of the set of rows selected before activation of the Advanced Search dialog. The search return is a highlighted set of rows in the table that match the search criteria.
• **Search all but keep current selection (implies OR)**—Specifies all text in the Analysis table as searchable regardless of the set of rows selected before opening the Advanced Search dialog box.
• **Search only current selection (implies AND)**—Specifies the text as the set of rows selected before opening the Advanced Search dialog box.

**Searching Contents of Results Table**

To search the contents of the Results table:

1. On the Analysis tab, right-click a cell in the Results table, and select **Advanced Search > Edit Search**.
2. Using the **Column Name** pull-down menu, select a column to search.
3. Using the **Operator** pull-down menu, assign an operator.
4. Enter the search term under **Value**.
5. If the search is case sensitive, select the **Case Sensitive** option.
6. Optional. Select the **Include Excluded Traces** option to include traces excluded from analysis in the search.
7. Optional. Select the **Treat Empty Cells as a Match** option to include empty cells in the search.
8. Optional. Click **Add Level** and repeat steps 2–4 to add additional levels to the search.

The set of rows selected in the table (when the Advanced Search dialog box was opened) can be applied to the search using **ALL**, **OR**, and **AND** operators.

a. Select **Search All** to search the entire table (**ALL** operator).

b. Select **Search All but keep current selection** to search the entire table with retention of the selection present when the Advanced Search dialog box was opened (**OR** operator).
c. Select Search only current selection to search only the rows selected when the Advanced Search dialog box was opened (AND operator).

The search can be saved by specifying a name under Search Name and clicking Save. The name of the saved search will appear in the Saved Searches list.

9. Click OK to execute the search.

Rows that contain cells meeting the search criteria will be highlighted.

**Editing a Search**

To edit a search:

1. On the Analysis tab, right-click any cell in the Results table, and select Advanced Search > Edit Search.

2. Select a saved search from the Saved Searches list.

3. Click Load Search.

   The parameters for the specified search are restored.

4. Edit the search (see steps 2–9 in “Searching Contents of Results Table” on page 133).

   The search can be saved by specifying a new name under Search Name and clicking Save. The name of the saved search will appear in the Saved Searches list.

5. Click OK to execute the search.

   Rows that contain cells meeting the search criteria will be highlighted.

**Color-Coding Data**

You can assign different colors to the binding curves as a follows:

- A particular color to user-selected results. This is useful when grouping for a global fit.
- Color according to a results category.

**Color-Coding User-Selected Results**

To color-code user-selected results:

1. Select one or more rows in the analysis table (click the row header).

2. Right-click and select Set Color.
3. In the color palette that appears, select a basic color or create a custom color. To define a custom color, click Define Custom Colors.

4. Click OK in the color palette.

The selected color is applied to the binding curve and appears in the table.

Results can be color-coded by category to group them for a global fit (for example, colored by compound), then fit using global fit by color. For the final display, the wells can be re-colored without affecting the results.

**Color-Coding Analysis Results by Category**

To color-code analysis results by category:

1. Right-click the analysis results table and select Set Color By.

2. Make a selection from the shortcut menu (Figure 5-54).

In Figure 5-54's example, category = sample concentration.
Figure 5-54: Setting Data Color by Category
**Sorting Analysis Results**

To sort results by any category (column header):

1. Click a column header.

   The results are displayed in descending order. In Figure 5-55, the results were color-coded by sample concentration, and then sorted.

2. Click the column header again to sort the results in ascending order.

*Figure 5-55: Color-Coded Analysis Results—Sorted by Color*
WORKING WITH Graphs

The active analysis results are automatically presented in three graphical formats:

- X-Y
- Iso-Affinity
- Steady State Analysis

**X-Y Graphs**

The X-Y graph is a scatter plot from user-selected analysis results (x and y-variables). Both axes may be presented on either a logarithmic or linear scale.

![Logarithmic scale option](select the analysis result to plot from the drop-down lists)

**Figure 5-56: X-Y Graph**

An X-Y plotting tool has been added to the Results tab of quantitation analysis. Previously available only in kinetics analysis, the X-Y plotting tool graphs several important parameters, such as binding rate, R2, calculated concentration, and residual. The axes may be independently selected to be logarithmic. In the example shown, the calculated concentration is plotted versus the R2 (Figure 5-57).
Iso-Affinity Graphs

The Iso-Affinity graph enables viewing of the continuum of \( k_{\text{dis}} \) and \( k_{\text{on}} \) values that generate a single value of \( K_D \), providing a convenient way to view both kinetic and affinity data. The value of the affinity constant, \( K_D \), is the ratio of the association rate \( k_{\text{on}} \) and dissociation rate \( k_{\text{dis}} \). A single value of \( K_D \) can, therefore, be obtained from varying values of \( k_{\text{on}} \) and \( k_{\text{dis}} \); for example, a \( K_D \) value of 1 uM can be the result of \( k_{\text{dis}} = 1 \times 10^{-3} 1/\text{S} \) and \( k_{\text{on}} = 1 \times 10^{-3} 1/\text{Ms} \) or \( k_{\text{dis}} = 1 \times 10^{-2} 1/\text{S} \) and \( k_{\text{on}} = 1 \times 10^{+4} 1/\text{Ms} \).

Each Iso-Affinity plot has two red lines that correspond to a single \( K_D \) value. The position of the \( K_D \) lines is determined by taking the average of all \( K_D \) values and plotting one redline 10 fold lower than the average and one red line 10 fold higher than the average.

\( \text{Figure 5-57: X-Y Plotting Tool} \)

\( \text{Figure 5-58: Iso-Affinity graph—X axis = } k_{\text{on}} \text{ Y-axis = } k_{\text{dis}} \)
Steady State Analysis Graphs

The Steady State Analysis graph (Figure 5-59) displays the results from the steady state analysis (see “Steady State Analysis Graphs” on page 140). The graph plots the response or $R_{eq}$ vs. concentration and the curve fit.

Figure 5-59: Steady State Analysis Graph

DATA EXPORT OPTIONS

The analysis results can be exported (.txt or .csv) or copied to the system clipboard. Information from the Data Selection, Processing, or Analysis windows can be selected to generate custom reports (.xls).

Figure 5-60: Data Export Options in the Analysis Window
The data export options include:

- **Export Fitting Results**—Saves the binding data and analysis results for each biosensor to a separate text file (.txt).
- **Export Table to .csv File**—Saves the results table to a .csv file that can be opened in a spreadsheet application.
- **Copy Table to Clipboard**—Saves the binding data and analysis results for the selected biosensors to the system clipboard.

**GENERATING A REPORT**

*NOTE: Generating reports for large data sets may take a few minutes. For faster report generation, minimize the number of items selected for the report. In particular, the sensor summary for a large data set can be time-consuming.*

To generate a report:

2. In the displayed dialog box, select the information to include in the report.
3. Confirm the default location to which the file will be saved or specify a different location.
4. Click Export.
**Experiment Summary Options**

To use the available experiment summary options, select the following from the Data Selection window (tab):

- Steps data table
- Assay steps data table
**Processing Options**

To use the available processing options, select the following from the Processing window (tab):

- Raw and aligned data
- Sensor tray image
- Sample plate image
- Processed results
- Sensor summary
- Sensor tray data table
- Sample plate data table
- Report points

**NOTE:** When working with large data sets, including the sensor summary in a report significantly increases the time required to generate the report.
Chapter 5: Basic Kinetics Analysis

Figure 5-63: Report Data Types—Processing Options—Raw Data and Aligned Data

Figure 5-64: Report Data Types—Processing Options—Sensor Tray and Sample Tray Information
Figure 5-65: Report Data Types—Processing Options—Processed Data

Figure 5-66: Types of Report Data Included by the Processing Options—Sensor Summaries
**Analysis Options**

To use the available analysis options, select the following from the Analysis window (tab):

- Kinetics analysis
- Iso-Affinity analysis
- Steady State analysis
Figure 5-68: Report Data Types—Analysis Options—Kinetics Analysis Results

Figure 5-69: Report Data Types—Processing Options—Iso-Affinity and Steady State Analysis Graphs
APPENDIX A:
Using Octet384 Systems with an Automation Interface

Automation Interface Overview ......................................................... 150
Design of the Automation Interface ................................................. 150
AUTOMATION INTERFACE OVERVIEW

The Octet System Data Acquisition software provides support for an automation interface using a COM port (RS-232) or a Transmission Control Protocol/Internet Protocol (TCP/IP) socket/port (Figure A-1).

![Figure A-1: Options for Automation](image)

An example application for testing the automation interface (AutomationClient.exe) is included in the applications and Dynamic Link Libraries (DLLs) installed with the Octet System Data Acquisition software. The file is located in the C:\Program Files\ForteBio\Data-Analysis directory.

**NOTES:** The automation interface can be used with Octet384 systems only. The examples that follow are illustrated using a TCP/IP connection, but the serial port connection behaves identically.

DESIGN OF THE AUTOMATION INTERFACE

The automation interface is designed to be as universal as possible, making no assumptions about the communication medium or the language of the client application connecting to the Octet System Data Acquisition software.

The following guidelines apply:

- All commands and responses are ASCII strings, one per line.
- All lines are terminated with both carriage-return and line-feed characters ("\r\n").
- Each command starts with the name of the command and may then be followed by required and optional parameters.
- Each parameter starts with a switch definition (a la dos/unix command line) followed by the parameter itself, which allows parameters to be sent in any order.
- The command or response is terminated with a new line (CR/LF) sequence.
- Parameters containing embedded spaces need to be enclosed in double quotes.
Automation Interface Control Setup

Before the Octet System Data Acquisition software can be controlled using an automation interface, the correct automation options must be set. To do this, go to File > Options and select the appropriate port in the Automation box (Figure A-1).

**NOTE:** The Octet System Data Acquisition software can be controlled via the Automation interface through a serial port (RS-232) or a TCP/IP socket.

**NOTE:** The Localhost option can be useful in developing the automation client on the same computer that runs the Octet System Data Acquisition software.

**NOTE:** ForteBio recommends that the Data File repositories be set using shared folders addressed by "UNC" folder names so that the internal path used by the Data Analysis application corresponds to the external path used to access/retrieve the data files recorded during the experiment. Alternatively, the path returned by the GetRunInfo command to access the data files from another computer on the LAN.

Analysis Automation API

```

// **********************************************************************
// ***
// // Copyright (c) 2011 ForteBio.
// // All rights reserved.
// //
// // **********************************************************************
// HEADER: AutomationAPI.h
// PURPOSE: Defines the commands supported by the automation API.
// AUTHOR:  BHI  Nov 2008
//
#elseifdef INC_ANALYSIS_AUTOMATIONAPI_H
#define INC_ANALYSIS_AUTOMATIONAPI_H

// NOTES:
```
The automation interface is string based. Commands and responses are strings, one per line. Each command starts with the name of the command and may then be followed by required and optional parameters. Each parameter starts with a switch definition (a la dos/unix command line) followed by the parameter itself. This allows parameters to be sent in any order. The command or response is terminated with a new line (CR/LF) sequence. Parameters containing embedded spaces must be enclosed in double quotes. Response items containing embedded spaces will be enclosed in double quotes.

Version of thew API described in this header file.

```c
const char AUT_API_VERSION[] = "1.0";
```

Status return values

```c
const char AUT_OK[] = "OK";
const char AUT_RUNNING[] = "Running";
const char AUT_ERROR[] = "ERROR";
const char AUT_BUSY[] = "Busy";
const char AUT_STOPPED[] = "Stopped"; // Stopped by user.
const char AUT_EOL[] = "\r\n";
```

Parameter switches for the LOAD command

```c
const char AUT_SWITCH_DATASET = 'd';
```

Parameter switches for the ANALYZE command

```c
const char AUT_SWITCH_PARAMS = 'p';
const char AUT_SWITCH_XMLINFO = 'x';
```

COMMAND API

```
const char AUT_CMD_VERSION[] = "Version";
// Returns the version of the app being automated, and the API version.
// Args: (none)
```
// Response: App product version (e.g. "6.3.1.12 1.0\r\n")

const char AUT_CMD_LOAD[] = "Load";
// Loads an experiment
// Args:
// -d <path> Path to experiment data files
// Response:
// "OK\r\n"
// "Error: <reason>\r\n"

const char AUT_CMD_ANALYZE[] = "Analyze";
// Runs an analysis
// Args:
// -p <path> Path to parameters (INI file)
// -x <path> Path to XML information file (optional, can be multiple XML info files)
// Response:
// "OK\r\n"
// "Error: <reason>\r\n"

const char AUT_CMD_STATUS[] = "Status";
// Returns status: OK=ready, Busy=running, Error=Action was terminated by an error.
// Busy is followed by descriptive information on the progress of the experiment (% complete)
// Args: (none)
// Response:
// "OK\r\n"
// "Busy\r\n"
// "Running (nn%)\r\n"
// "Error: <reason>\r\n"

#define // INC_ANALYSIS_AUTOMATIONAPI_H
APPENDIX B:
21 CFR Part 11 Software Administrator Options

Installing the Data Acquisition 7.0 21 CFR Part 11 Software .............................................. 156
Installing the Data Analysis 7.0 21 CFR Part 11 Software .................................................. 159
Installing the ForteBio GxP Server Module ................................................................. 162
Administrator Account Setup .......................................................................................... 165
Starting an Administrator User Session ........................................................................ 169
Accessing Administrator Options .................................................................................. 172
Accessing the ForteBio GxP Server Module Directly ................................................... 187
Restarting the ForteBio GxP Server Module ................................................................. 190
INSTALLING THE DATA ACQUISITION 7.0 21 CFR PART 11 SOFTWARE

To install the Data Acquisition 7.0 21 CFR Part 11 software:

1. Insert the software V7.0 CFR CD (7.00.35/7.0.0.9) into your CD drive.
   - If the Autoplay dialog box displays, choose to open the CD to view files.
   - If the Autoplay dialog box does not display, navigate to the CD using Windows Explorer.
   Optical drives are typically found under the D:\ or E:\ drive.

2. Double-click DataAcquisition-CFR-7_0_0_x.exe to launch the installation wizard (see Figure B-1).

3. Click Next to display the Choose Install Location dialog box (Figure B-2).
Installing the Data Acquisition 7.0 21 CFR Part 11 Software

Figure B-2: Choose Install Location Dialog Box

The default location for the software on the local machine is C:\Program Files\ForteBio\DataAcquisition7.

4. Click Next to accept this path location.

The Choose Start Menu Folder dialog box displays (Figure B-3).

Figure B-3: Choose Start Menu Folder Dialog Box

The default Start Menu folder is ForteBio.

5. Click Install.

The installation wizard takes a few seconds to install.

When the installation is complete, the installation wizard displays the Completing the Data Acquisition 7.0 Setup Wizard dialog box (Figure B-4).
6. Click Finish to complete the installation.

Figure B-4: Completing the Data Analysis 7.0 Setup
INSTALLING THE DATA ANALYSIS 7.0 21 CFR PART 11 SOFTWARE

To install the Data Analysis 7.0 21 CFR Part 11 software:

1. Insert the software CD into your CD drive.
2. Navigate to the window listing the files located on the installation CD.
3. Double-click DataAnalysis-CFR-7_0_0_x.exe to launch the installation wizard (see Figure B-5).

Figure B-5: Data Analysis 7.0 (for 21 CFR Part 11) Software Setup Wizard

4. Click Next to display the Choose Install Location dialog box (Figure B-6).

Figure B-6: Choose Install Location Dialog Box
The default location for the software on the local machine is C:\Program Files\ForteBio\DataAnalysis7.

5. Click Next to accept this path location.

The Choose Start Menu Folder dialog box displays (Figure B-7).

![Figure B-7: Choose Start Menu Folder Dialog Box](image)

The default Start Menu folder is ForteBio.

6. Click Install.

The installation wizard takes a few seconds to install (Figure B-8).

![Figure B-8: Installation Progress](image)
The installation wizard displays the Completing the Data Analysis 7.0 Setup Wizard dialog box (Figure B-9).

![Completing the Data Analysis 7.0 Setup Wizard](image)

*Figure B-9: Completing the Data Analysis 7.0 Setup*

7. Click Finish to complete the installation.
INSTALLING THE FORTEBIO GXP SERVER MODULE

The ForteBio GxP Server module can be installed and run from the following locations:

- A local host computer where the ForteBio Data Acquisition or Data Analysis 7.0 21 CFR Part 11 software is installed
- A remote host computer networked to a machine where the ForteBio Data Acquisition or Data Analysis 7.0 21 CFR Part 11 software is installed

Upon launching the Octet System Data Acquisition or Data Analysis 7.0 CFR 11 software, you are required to select the GxP Server module host location. If the GxP Server module is installed in multiple locations, you can select any host server. The user session event record will be saved only to the host location selected, making it possible to have records for the same user in multiple locations.

NOTE: For administrators only. To ensure that all records are saved to one location, ForteBio recommends that administrators install a single copy of the ForteBio GxP Server module on the network that can then be accessed by all users.

To install the ForteBio GxP Server software:

1. Navigate to the window listing the files located on the installation CD.
2. Double-click ForteBio GxP Server 7.0.exe to launch the installer.
3. If prompted with the Do you want the following program from an unknown publisher to make changes to this computer? message, reply Yes.

The installation wizard should display (Figure B-10).

Figure B-10: ForteBio GxP Server 7.0 Software Setup Wizard
4. Click Next to display the Choose Install Location dialog box (Figure B-11).

![Figure B-11: Choose Install Location](image)

The default location for the software on the local machine is `C:\Program Files\ForteBio\DataAnalysis7`.

5. Click Next to accept this path location.

The Choose Start Menu Folder dialog box displays (Figure B-12).

![Figure B-12: Choose Start Menu Folder Dialog Box](image)

The default Start Menu folder is ForteBio.

6. Click Install.

The installation wizard takes a few seconds to install (Figure B-13).
The installation wizard displays the Completing the ForteBio GxP Server 7.0 Setup Wizard dialog box (Figure B-14).

7. Click Finish to complete the installation.
ADMINISTRATOR ACCOUNT SETUP

To set up the administrator account:

1. Launch the Octet System Data Acquisition or Data Analysis software by double-clicking the respective desktop icon; see Figure B-15.

   ![Figure B-15: Data Acquisition or Data Analysis Software Desktop Icons](image)

   The Login dialog box displays (Figure B-16).

   ![Figure B-16: Login Dialog Box](image)

   2. Select a Server location by clicking ... (browse).

      The Authentication Server dialog box displays (Figure B-17).

   ![Figure B-17: Authentication Server](image)
3. Click Default to recall the default server settings of localhost and Port 2002.
   - **Local host**—If the local computer is to be used as the GxP Server module host, click the Localhost check box. Change the Port number if needed.
   - **Remote host on same subnet**—If the GxP Server module is hosted on the same subnet, deselect the Localhost check box and click Find. A list of potential GxP Server module addresses will be listed. Choose the desired location from the list and click OK.

![Choose Server Address](image1)

*Figure B-18: Choose Server Address*

   - **Remote host on another subnet**—If the GxP Server module is hosted on a different subnet, deselect the Localhost check box. Enter the IP address of the computer hosting the GxP Server module.

![Authentication Server](image2)

*Figure B-19: Authentication Server*

When the GxP Server module host location has been selected or entered, click OK to save changes and exit the Authentication Server dialog box. The GxP Server module location will now be listed as the Server in the Login dialog box.
NOTE: Once the GxP Server module host location is selected, this location will be used as the default selection for the administrator account. It does not need to be reselected each time a new session is initiated.

4. Select Administrator from the User drop-down list (Figure B-20).
5. Leave the Password blank, set the Project to (none) and click OK (Figure B-21).

The Change Password dialog box displays; see Figure B-22.
6. Enter a **New password** and **Password reminder** (optional) and click **OK**.

The Octet System Data Acquisition or Data Analysis software launches and initiates an administrator user session that will allow access to administration options.
STARTING AN ADMINISTRATOR USER SESSION

Administrators initiate new user sessions the same way non-administrative users do.

1. Launch the Octet System Data Acquisition or Data Analysis software by double-clicking the respective desktop icon; see Figure B-23.

![Data Acquisition or Data Analysis Software Desktop Icons](Figure B-23: Data Acquisition or Data Analysis Software Desktop Icons)

The Login dialog box displays; see Figure B-24.

![Login Dialog Box](Figure B-24: Login Dialog Box)

2. Confirm that the Server location is correct. If not, see “Administrator Account Setup” on page 165.

3. Select Administrator from the User drop-down list (Figure B-25).
4. Enter your Password. Click ? for a password reminder (Figure B-26) if necessary.

5. If required, select a project from the Project drop-down list (Figure B-27).
6. Click OK.

The Octet System Data Acquisition or Data Analysis software launches and initiates the administrator session. During the session, the administrator account and project selected at login are displayed in the Data Acquisition software status bar.

**NOTE:** Administrator and user sessions are automatically closed after a period of inactivity set using the `UserIdleMin` constant. Please see “Administrator Constants” on page 182 for more information.
ACCESSING ADMINISTRATOR OPTIONS

The 21 CFR Part 11 software Server Administration options allow administrators to manage users, groups, projects and constants and view associated events.

These options can be accessed in the Octet System Data Acquisition and Data Analysis software or by launching the ForteBio GxP Server module directly.

- **Data Acquisition and Data Analysis software**—Click Security > Server Administration (Figure B-28).

  ![Data Acquisition Software](Image)
  ![Data Analysis Software](Image)

  *Figure B-28: Security > Server Administration Menu*

- **ForteBio GxP Server module on network location**—Double-click the FBServerConfig.exe file in the FBServer7 folder from the installed location (Figure B-29).

  ![Installation Location](Image)

  *Figure B-29: Installation Location*

- **ForteBio GxP Server module on a local host computer**—Double-click the ForteBio GxP Server desktop icon (Figure B-30).
The ForteBio GxP Server Configuration window displays.

**Administrator Tabs**

Five tabs are available in the ForteBio GxP Server Configuration window:

- **Users**—Allows user and password management and individual privileges selection.
- **Groups**—Allows user group management and group privileges selection.
- **Projects**—Allows project management and setup.
- **Constants**—Allows setup of GxP server parameters.
- **Events**—Displays event logs for individual user accounts, projects, or machines.

Click any of the tabs to view the respective information contained within the tab.

**Tab View**

Each tab displays a list of administrator entries and associated setting information that can be sorted by clicking any of the column headers (Figure B-31).

**Tab Menu**

Right-clicking an entry or a blank area in the tab displays the tab menu. Tab menu options vary depending on the tab selected.
User Account Administration

The Users tab allows administrators to add and delete user accounts, as well as set and change individual user account privileges and passwords.

Creating a New User Account

To create a new user account:

1. Right-click anywhere in the Users tab and select New User, or double-click in a blank area; see Figure B-32.

![New User Menu](image1)

Figure B-32: New User Menu

The New User dialog box displays (Figure B-33).

![New User Dialog Box](image2)

Figure B-33: New User Dialog Box
2. **Assign Account Details.** Enter the user’s **Login name**, **Full name**, **Information** (optional), **Password**, and **Password reminder** (optional).

3. **Assign a User Group.** Select a user group from the **Group** drop-down list. The following default group selections are available:
   - **Administrator**—Add, delete, and change user accounts and groups.
   - **Supervisor**—Review data and events.
   - **Developer**—Create, run, save, and export data.
   - **Lab User**—Only run experiments.
   - **Guest**—No explicit privileges; these must be assigned by the administrator.

   If other user groups have been created by an administrator, they will also be available for selection in the **Group** drop-down box. For more information, please see “Creating a New User Group” on page 179.

4. **Assign Privileges.** Each user account can be assigned specific privileges. The privileges displayed initially will be those defined in the user group selected in the previous step. Table B-1 outlines the privileges for the default user groups. If needed, change user account privileges by selecting or deselecting the check boxes next to each privilege.

   - **Administration**—Can administer the user database.
   - **Review**—Can review changes and events.
   - **Change**—Can change methods and configuration values.
   - **Plate**—Can change sample plate properties.
   - **Run**—Can run experiments and analyses.

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Administrator</th>
<th>Supervisor</th>
<th>Developer</th>
<th>Lab User</th>
<th>Guest</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Review</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plate</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Run</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

5. **Options**—Click the **Password does not expire** check box if desired. By default, this check box is not selected. Clicking this option will let user account passwords expire at the set **PasswordTTL** constant. For more information on setting constants, see “Administrator Constants” on page 182.

6. Click **OK** to save changes and exit.
**Viewing and Changing User Account Settings**

To view and change user account settings:

1. On the Users tab, right-click the user account and select Edit User, or double-click the user account.

   The Edit User window displays (Figure B-34).

![Edit User Dialog Box](image)

*Figure B-34: Edit User Dialog Box*

2. If needed, modify the user account settings. For more details on individual settings, see “Creating a New User Account” on page 174.

3. Click OK to save changes and exit.

**Deleting User Accounts**

To delete a user account:

1. On the Users tab, right-click the user account and select Delete User.

2. Click OK in the dialog box displayed.


Changing User Account Passwords

To change a user account password:

1. On the Users tab, right-click the user account and select Set Password.

   The Change Password dialog box displays (Figure B-35).

   ![Change Password Dialog Box](image)

   **Figure B-35: Change Password Dialog Box**

2. Enter the New Password, confirm the new password, and provide a Password reminder (optional).

3. Click OK to save changes and exit.

Changing the Administrator Password

To change the administrator password:

1. Initiate a new administrator user session.

2. When the software launches, on the main menu, click Security > Change Password.

   The Change Password window displays (Figure B-36).

   ![Change Password Dialog Box (Administrator)](image)

   **Figure B-36: Change Password Dialog Box (Administrator)**
NOTE: You can also access the Change Password dialog box by right-clicking on the administrator account in the Users tab and selecting Set Password from the tab menu.

3. Enter the Current password for your user account. Click ? for a password reminder.
4. Enter the New Password and Password reminder (optional).
5. Click OK to save changes and exit.

Group Administration

The Groups tab (Figure B-37) allows administrators to add and delete user groups as well as set and change group privileges.

![Figure B-37: ForteBio GxP Server Administration](image)

When a user account is assigned to a user group, the privileges defined in the group are also applied to the individual user account. The following default user groups are available and the privileges assigned to each are shown Table B-2:

- **Administrators**—Can add, delete and change user accounts and groups
- **Supervisors**—Can review data and events
- **Developers**—Can create, run, save and export data
- **Lab Users**—Can only run experiments
- **Guests**—Have no explicit privileges, these must be assigned by the administrator
Creating a New User Group

To create a new user group:

1. Right-click anywhere in the Groups tab and select New Group or double-click in a blank area.

   The New Group window displays (Figure B-38).

   ![Figure B-38: New Group Dialog Box]

   ![Figure B-38: New Group Dialog Box]

2. Enter the Group name and Information (optional).

3. Privileges—Each group can be assigned specific privileges. Add group privileges by selecting or de-selecting the check boxes next to each privilege:
   - Administration—Can administer the user database
   - Review—Can review changes and events
   - Change—Can change methods and configuration values
   - Plate—Can change sample plate properties
   - Run—Can run experiments and analyses

4. Click OK to save changes and exit.

---

Table B-2: Default User Group Privileges

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Administrator</th>
<th>Supervisor</th>
<th>Developer</th>
<th>Lab User</th>
<th>Guest</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Review</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plate</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Run</td>
<td></td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Octet System Data Analysis User Guide, Release 7.1
Viewing and Changing Group Settings

To view and change group settings:

1. Right-click on the group and select Edit Group, or double click the group.

   The Edit Group window displays (Figure B-39).

   ![Edit Group Dialog Box](image)

   **Figure B-39: Edit Group Dialog Box**

2. If needed, modify the group settings. For more details on individual settings, see “Creating a New User Group” on page 179.

3. Click OK to save changes and exit.

Deleting a User Group

To delete a user group:

1. Right-click the group and select Delete Group.

2. Click OK in the dialog box displayed.
**Project Administration**

The Projects tab (Figure B-40) allows administrators to add and delete user projects. Projects are selected when a new user session is initiated in the Octet System Data Acquisition or Data Analysis software, allowing all user, system and software events for a particular project to be monitored.

![Projects](image)

*Figure B-40: Projects*

**Creating a New Project**

To create a new project:

1. Right-click anywhere in the Projects tab and select New Project, or double-click in a blank area.
   
   The New Project window displays (Figure B-41).

   ![New Project](image)

   *Figure B-41: New Project*

2. Enter the Project name and Information (optional).
3. Click OK to save changes and exit.
**Viewing and Changing Project Settings**

To view and change project settings:

1. Right-click on the project and select Edit Project, or double-click on the project.
   
   The Edit Project window displays (Figure B-42).

   ![Edit Project](image)

   **Figure B-42: Edit Project**

2. If needed, modify the project settings.
3. Click OK to save changes and exit.

**Deleting a Project**

To delete a project:

1. Right-click the project and select Delete Project.
2. Click OK in the dialog box displayed.

**Administrator Constants**

The Constants tab allows administrators to set GxP Server module constant settings. These constants are applied to all user accounts and sessions.

![Constants Tab](image)

**Figure B-43: Constants Tab**
Available administrator constants and their associated value ranges are shown in Table B-3.

**Table B-3: Administrator Constants**

<table>
<thead>
<tr>
<th>Constant</th>
<th>Description</th>
<th>Default Value</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>CredentialsTTL</td>
<td>The number of days that the server settings are stored in the cache. This allows the software to operate in case the server is temporarily down.</td>
<td>5</td>
<td>Minimum=0, no maximum value</td>
</tr>
<tr>
<td>PasswordMinLength</td>
<td>Minimum number of characters that a password must contain.</td>
<td>0</td>
<td>Minimum=0, no maximum value</td>
</tr>
<tr>
<td>PasswordSecure</td>
<td>Level of password complexity. Setting the constant to 0 has no password restrictions. Setting the constant to 1 requires passwords to contain at least one alpha, one numeric, and one punctuation character.</td>
<td>0</td>
<td>0–1</td>
</tr>
<tr>
<td>PasswordTTL</td>
<td>Amount of time that a password is allowed to remain unchanged.</td>
<td>180</td>
<td>Minimum=0, no maximum value</td>
</tr>
<tr>
<td>UserIdleMin</td>
<td>Idle time allowed during a user session after which the session is automatically closed.</td>
<td>15</td>
<td>Minimum=0, no maximum value</td>
</tr>
</tbody>
</table>
Creating a New Constant

To create a new constant:

1. Right-click anywhere in the Constants tab and select New Constant, or double-click in a blank area.

   The New Constant window displays (Figure B-44).

   ![Figure B-44: New Constant](image)

   2. Enter the Constant name and Value. Refer to Table B-3 for a list of available constants and value ranges.

   3. Click OK to save changes and exit.

Viewing and Changing Constants

To view and change constants:

1. Right-click the constant and select Edit Constant, or double-click the constant.

   The Edit Constant dialog box displays (Figure B-45).

   ![Figure B-45: Edit Constant Dialog Box](image)

   2. If needed, modify the constant settings. For more information on available constants and their values, see Table B-3 on page 183.

   3. Click OK to save changes and exit.
Deleting a Constant

To delete a constant:
1. Right-click the constant and select Delete Constant.
2. Click OK in the dialog box displayed.

Event Log

The Events tab allows administrators to view all the user, system, and software event information recorded by the ForteBio GxP Server module.

![Figure B-46: Event Log](image)

Events are tracked for individual user accounts, projects and machines. By default, a historical log of all events recorded on the active ForteBio GxP Server module displays.
Viewing Events

To view events for a specific user account, project, or computer, click the User (Figure B-47), Project, or Machine drop-down list, and select an entry:

![Figure B-47: Viewing Events from the User Drop-Down List](image)

**NOTE:** Selections can be made in either one or all of the User, Project, or Machine drop-down lists.

The list then only displays events for the entries selected (Figure B-48).

![Figure B-48: Selected Entries](image)

In addition to the specific user, project, and machine selections, the following list options are also available:

- **(any)**—Displays all user, project, or machine events.
- **(none)**—Displays all user and machine events not associated with a specific project (Project list only).
ACCESSING THE FORTEBIO GXP SERVER MODULE DIRECTLY

Administrators can directly access the ForteBio GxP Server module without initiating an administrator user session. Direct access provides server testing options, as well as access to all administrative functions discussed earlier in this section.

To access the ForteBio GxP Server module directly:

- **If the ForteBio GxP Server module is installed on a network location**—Double-click the FBServerConfig.exe file in the FBServer7 folder from the installed location (Figure B-49).

![Figure B-49: ForteBio GxP Server Module Installed on a Network Location](image)

- **If the GxP Server module is installed on a local host computer**—Double-click the ForteBio GxP Server desktop icon (Figure B-50).

![Figure B-50: ForteBio GxP Server Desktop Icon](image)

The ForteBio GxP Server Configuration window displays (Figure B-51).
Use of the User, Groups, Projects, Constants, and Events tabs are described in “Accessing Administrator Options” on page 172.
**ForteBio GxP Server Module Testing**

The ForteBio GxP Server module can be tested to ensure it is accessible and functioning properly? Wasn’t sure about this functionality.

To test the ForteBio GxP Server module:

1. Optional. In the **Connections to Clients** box (Figure B-52), make changes to the server settings if necessary.

   ![Figure B-52: Connection to Clients](image)

   **Figure B-52: Connection to Clients**

2. Click **Apply & Test**.

   If the ForteBio GxP Server module is found and functioning properly, the following message displays (Figure B-53):

   ![Figure B-53: Message Confirmation of Found Server](image)

   **Figure B-53: Message Confirmation of Found Server**

   To return to the originally configured ForteBio GxP Server module settings, click **Default** at any time.
RESTARTING THE FORTEBIO GXP SERVER MODULE

If the host location of the GxP Server module cannot be found during user login, or if you are unable to log in with valid credentials, the ForteBio GxP Server module may be offline and must be restarted.

NOTE: ForteBio recommends contacting your IT department to confirm whether or not network or firewall settings may have been changed. This may also be preventing access to the ForteBio GxP Server module.

To restart the ForteBio GxP Server module, choose one of the following two options:

- If the ForteBio GxP Server module is installed on a network location—Double-click the FBServer.exe file in the FBServer7 folder from the installed location (Figure B-54).

  ![Figure B-54: ForteBio GxP Server Module Installed on a Network Location](image)

- If the GxP Server module is installed on a local computer—Double-click the Restart Server desktop icon (Figure B-55).

  ![Figure B-55: Restart Server Desktop Icon](image)

The Restart Server console display momentarily as the ForteBio GxP Server module restarts (Figure B-56).
Figure B-56: Restart Server Console
Index

Symbols

.fmf files (method files) 76

Numerics

1 to 2 Bivalent Analyte Model 114
2 to 1 (HL) Model 114

A

About ForteBio Data Analysis (menu) 26
accessing GxP Server module 187
Add Folders menu 70, 122
Add Level, Advanced Search option 132
Add to Table, Fitting view option 125
adding Replicate Group from the Sample Plate Table (figure) 52
Additional Graphs, view option 126
administrator constants 183
administrator password, changing 177
Advanced Search dialog box (figure) 132
Advanced Search options
   Add Level 132
   Case Sensitive 133
   Column 132
   Include Excluded Traces 133
   listed 132
   Operator 132
   Remove Level 133
   Search All 133
   Search all but keep current selection (implies OR) 133
   Search only current selection (implies AND) 133
   Treat Empty Cells as Match 133
   Value 132
   Advanced Search tool 132
   Advanced Search, display option 131
   Affinity constant 129
   affinity constant KD 80
   alert threshold value, editing 64
   Align All Baselines alignment option 91
   Align by Begin Point alignment option 91
   Align by End Point alignment option 91
   Align to Baseline, interstep correction feature 105
   Align to Dissociation, interstep correction feature 105
   Align X viewing option
      basic kinetics analysis 85
      quantitative analysis 54
      aligning
the Y axis (figure) 105
alignment options
Align All Baselines 91
Align by Begin Point 91
Align by End Point 91
All Aligned to One Step 91
Show All Steps Aligned 91
All Aligned to One Step alignment option 91
analysis
excluding samples 47
including samples 47
options, listed 146
Analysis results table (figure) 117
Analysis results table display options
Advanced Search 131
Exclude Wells 131
Include Wells 131
Invert Selection 132
listed 131
Order Columns 132
Select All Rows 132
Set Color 131
Set Color By 131
Set Color By Group 131
Size Columns by Data 132
Size Columns by Title 131
Analysis Results table shortcut menu (figure) 131
analysis results, sorting by any category 137
analysis settings
saving 66
specifying 58
Analysis window (figure) 115
Analysis window with sample curve fitting results (figure) 123
Analyze Data button 71
analyzed data
Binding Rate 63
BR AVG 62
BR CV 62
BR SD 62
Calc. Conc. 63
Concentration avg 62
Concentration CV 62
Concentration SD 62
dilution factor 62
flip 62
Group Type 62
information 62
kinetics analysis
Index (parameter) 129
Lot Number 62
plate 62
quantitative analysis
   Index (parameter) 62
r2 (COD) 63
Replicate Groups 62
Residual 63
Sample ID 62
sensor 62
Sensor Type 62
well concentration 62
Well Information 63
analyzing
   binding data 80
   binding data (kinetics) 80
   binding data (quantitative) 57
   entire time duration of selected step 115
   equilibrium state data 119
   experiments 44
   processed kinetic data
      curve fitting analysis 114
      steady state analysis 118
   applications, closing 24
Apply All, Report Point Analysis feature 111
Apply, Report Point Analysis feature 111
applying
   reference subtraction during data processing 99
   sample alerts 65
   standards alert 64
assigning
   different colors to binding curves 134
   Replicate Groups in the Sample Plate Map 50
   Replicate Groups in the Sample Plate Table 52
Assoc. (Sample) Loc., kinetic analysis result 129
Association & dissociation, analysis option 114
Association only, analysis option 114
Association, analysis option 115
Audit Trail
   described 38
   listing events 39
   sorting events 39
   viewing 38
Auto Scale, Fitting view option 124
Autoplay dialog box 156
Average from, steady state kinetics analysis option 119
Average Reference Sensors
   reference subtraction method (figure) 104
reference subtraction method, described 103

B
Baseline Loc., kinetic analysis result 129
basic kinetics experiment 76
batch analysis, running 121
batch mode
kinetics analysis 119
quantitation analysis 67
batch mode options
kinetics 121
quantitative 70
Table Information, kinetics 122
Use one for all folders
kinetics 121
quantitation 70
Use the one in each folder
kinetics 121
quantitative 70
Use the original data folder 70
Use this folder 70
Well Information
kinetics 121
quantitation 70
batch process data sets with individual .ini files 119
Binding 1 (nm shift) 112
Binding 2 (nm shift) 112
binding chart
  copying 113
  including toolbar and data grid 109
  printing 113
  shortcut menu (figure) 113
  viewing in separate window (figure) 108
binding curve chart, opening in a separate window 56, 86
binding curves
  after user-specified reference subtraction method is used 106
  after user-specified Y alignment 106
  assigning different colors 134
  association steps aligned at the same time point 106
  customizing appearance 56, 86
  displaying
    all ligand biosensors 124
    from each biosensor 124
  viewing
    basic kinetic analysis 84
    quantitative analysis 53
    with no reference subtraction 106
binding data
  analyzing (kinetics) 80
  analyzing (quantitative) 57
binding data, analyzing 80
Binding Rate Equation, processing parameter 60
binding rate equations
  initial slope 60
  R equilibrium 60
Binding Rate, analyzed data 63
binding rates, calculated (figure) 96
binding signal
  at Time 1 112
  at Time 2 112
biosensor data, viewing specific 127
biosensor number 62
biosensor types, changing (figure) 98
biosensors
  selecting (figure) 97
  selecting and confirming to analyze (figure) 106
  selecting for analysis 79
biosensors, selecting 97
BR AVG, analyzed data 62
BR CV, analyzed data 62
BR SD, analyzed data 62
By Color, analysis option 115

By Sensor, analysis option 115

C
Calc. Conc., analyzed data 63
calculated binding rates (figure) 96
calculated response at equilibrium 130
calibration curves 71
Case Sensitive, Advanced Search option 133
Change Password dialog box (figure) 41
Change Password menu 25
Change Project menu 25
Change Well Type menu 98
changing
  administrator password 177
  biosensor type (figure) 98
  color of user-selected results (figure) 135
  constants 184
  file type available for selection 37
  group settings 180
  project settings 182
  projects during a user session 40
  sample designations 81
  quantitation analysis 46
  sample designations (figure) 46, 81
sample type 93
sample type in the sample plate map (figure) 94
sample type in the sample table (figure) 94
step type (figure) 79
user account password 177
user account settings 176
user password 41
Choose Install Location dialog box (figure) 157, 159
Choose Start Menu Folder dialog box (figure) 157, 160, 163
closing
  all experiments 57, 87
  application 24
  experiment 57, 87
  kinetics experiment (figure) 87
  selected experiment (left) or all experiments (right) in the Quantitation or Kinetics folder (figure) 57
closing a kinetics experiment (figure) 87
COD (coefficient of determination) 130
coefficient of determination 130
color of the biosensor binding curve 129
Color, kinetic analysis result 129
color-coded analysis results
  enabling 131
sorted by color (figure) 137
color-coding
  data 134
  results by category 135
  user-selected results 134
Column, Advanced Search option 132
compliant experiments, generated 36
compliant features for 21 CFR Part 11 35
Conc. (nM), kinetic analysis result 129
Concentration (mM) 112
Concentration avg, analyzed data 62
Concentration CV, analyzed data 62
Concentration SD, analyzed data 62
collection values, setting 95
confirming
  biosensors to be analyzed (figure) 106
  Reference Well is subtracted from the sample wells (figure) 100
connecting Octet instrument to computer 22
Connections to Clients box 189
constants
  administrator 183
  changing 184
  creating 184
  deleting 185
  viewing 184
Constants tab 182
contacting ForteBio technical support 20
contiguous biosensors, selecting (figure) 91
conventions, used in this guide 20
Copy Table to Clipboard, data export option 141
Copy to Clipboard menu 97
copying
  binding chart 113
  sample plate map 97
  sensor tray map 97
creating
  kinetic Settings_DataAnalysis.ini file 119
  kinetic Settings_TableInfo.xml file 120
  kinetic Settings_WellInfo.xml file 120
new constant 184
new project 181
new user account 174
new user group 179
  Settings_DataAnalysis.ini file 68
curve display, customizing 108
curve fitting analysis 80
curve fitting kinetics analysis options
  Fitting-Global (Full) 114
  Fitting-Local 114
  Model 114
  Rmax Unlinked option for Global Fitting 115
  Steps to Analyze 114
Curve fitting, kinetic analysis type 113
custom reports 140
customizing
  binding curve appearance 56, 86
  curve display 108
  graph appearance 56, 86
  graph display 108
Cycle, kinetic analysis result 130

D
data
  excluding from analysis 116
  exporting 71
Data Acquisition User Guide, opening
  online version 26
Data Acquisition, icon 6
data analysis session, using 44, 76
Data Analysis User Guide (menu) 26
Data Analysis, icon 6
data color, setting by category 136
data export options
  Copy Table to Clipboard 141
described 140
Export Fitting Results 141
Export Table to .csv File 141
in the Analysis window (figure) 140
listed 141
Data Options, view option 126
data processing 106
applying reference subtraction 99
reference subtraction methods 100
Data Selection tab 48
Data Selection tab (figure) 44
Data Selection window
displaying experiment summary information (figure) 78
editing sample information, kinetics (figure) 82
editing sample information, quantitative (figure) 48
example (figure) 68
loading an experiment, kinetics (figure) 77
loading an experiment, quantitative (figure) 45
opening an experiment (figure) 45
viewing options (table) 54
data viewing options 127
DataAcquisition-CFR-7_0_0_x.exe 156
Define Custom Colors menu 135
defining
Replicate Groups 49
Delete Constant menu 185
deleting
constants 185
project 182
user account 176
user group 180
determining
binding rate 63
sample concentration 44
digital signatures, verifying 36
dilution factor 62
discontiguous biosensors, selecting (figure) 91
display options, viewing shortcut menu of 131
displaying
graphs organized into groups 124
license information 26
Octet System Data Acquisition software properties 26
selected step data from a kinetic assay (figure) 93
Dissoc. Loc., kinetic analysis result 129
Dissociation only, analysis option 114
Dissociation, analysis option 115
Do not use alerts, threshold value 64
Dose Response–4PL (Default 59
Dose Response–4PL (Weighted Y) 59
Dose Response–4PL (Weighted Y2) 59
Dose Response–5PL (Default 59
Dose Response–5PL (Unweighted) 59
Dose Response–5PL (Weighted Y) 59
Double Reference
    reference subtraction method (figure) 103
    reference subtraction method, described 102

E
Edit Group window 180
Edit Legends viewing options
    basic kinetics analysis 85
    quantitative analysis 55
Edit Sample Information dialog box (figure) 50
editing
    a search 134
    alert threshold value 64
    experiments 81
    processing parameters in the Results window (figure) 49
    processing parameters, kinetics 83
    processing parameters, quantitative 48
    standard concentration information 48, 82
    well information 48, 82
Electrical hazard symbol 20
electronic signature of method (.fmf) and data (.frd) files 36
ending a user session 42
equilibrium response 80
equilibrium state data, analyzing 119
estimate of the goodness of the curve fit 130
Event Log (figure) 185
events
    listed in the Audit Trail 39
    sorting in Audit Trail 39
    tracking 185
    viewing 39, 186
Events tab 185
Exclude Wells
display option 131
menu 47
Exclude Wells for Analysis menu 99
excluding
data from analysis 116
sample from subsequent analyses 62
samples from analysis, kinetics (figure) 82
samples from analysis, quantitative 47
samples from analysis, quantitative (figure) 47
wells from analysis, described 99
wells from the biosensor table (figure) 116
Exit (menu) 24
experiment method file 76
experiment method file, loading 24
experiment summary options 142
experiment, quantitation, described 44
experiments
  closing all
    kinetics 87
    quantitative 57
  closing one
    kinetics 87
    quantitative 57
  editing 81
  loading for analysis, kinetics 76
  loading for analysis, quantitative 44
Export Aligned Step (.csv files) menu 91
Export button 141
Export File, Report Point Analysis feature 111
Export Fitting Results, data export option 141
Export Table to .csv File, data export option 141
exporting raw data 91

F
FBServer.exe file 190
file type, changing 37
Fit Curves! button 116
Fitting view
  grouped option (figure) 127
  individual option (figure) 125
  stacked option (figure) 124
Fitting view and Residual view, stacked option (figure) 124
Fitting view options
  Add to Table 125
  Auto Scale 124
  Full Scale 124
  Grouped 124
  Individual 124
  listed 124
  Options 124
  Refresh 124
  Remove All 125
  Report Points 124
  Stacked 124
  Time (sec) 124
  Use__Point Average 125

Octet System Data Analysis User Guide, Release 7.1
Y Axis Scaling 124
Fitting-Global (Full) options
  By Color 115
  By Sensor 115
Fitting-Global (Full), curve fitting kinetics analysis option 114
Fitting-Local options
  Full 114
  Partial 114
Fitting-Local, curve fitting kinetics analysis option 114
Flip Data viewing options
  quantitative analysis 54, 85
flip, analyzed data 62
ForteBio GxP Server 7.0.exe 162
ForteBio GxP Server desktop icon 173
ForteBio GxP Server module, accessing 187
ForteBio GxP Server module, installing 162
ForteBio technical support, contacting 20
ForteBio Web Site (menu) 26
Full R2, kinetic analysis result 130
Full Scale, Fitting view option 124
Full X2, kinetic analysis result 130
Full, analysis option 114
Fuse symbol 20

generating a report 141
graph display, customizing 108
Graph Options, view option 126
Graph Size in Pixels, view option 126
graph, customizing appearance 56, 86
graphical formats 138
Group Graphs By, view option 126
group settings, viewing 180
Group Type, analyzed data 62
Grouped View options
  Additional Graphs 126
  Data Options 126
  Graph Options 126
  Graph Size in Pixels 126
  Groups Graphs By 126
  Legend by 126
Grouped View Options dialog box (figure) 126
Grouped View viewing options, quantitative analysis 54
Grouped, Fitting view option 124
grouping data
  by color 115
  by sensor 115
grouping results for viewing 126
GxP Server module
accessing 187
restarting 190
testing 189

H
Heat/hot symbol 20
Heterogeneous Ligand model 114

I
icons
  Data Acquisition 6
  Data Analysis 6
Ignore error in files option 79
Ignore errors in files when loading viewing option
  basic kinetics analysis 85
  quantitative analysis 54
Include Excluded Traces, Advanced Search option 133
Include Wells
  display option 131
  menu 47
Include, kinetic analysis result 129
including
  sample in subsequent analyses 62
  samples from analysis 47
Index (parameter)
  working with analyzed data
  quantitative analysis 62
Individual, Fitting view option 124
information, analyzed data 62
Initial Slope equation 60
Input times after beginning of Association Step 111
installing
  Data Acquisition 7.0 21 CFR Part 11 software 156
  Data Analysis 21 7.0 CFR Part 11 software 159
  ForteBio GxP Server 162
  ForteBio GxP Server module 162
interstep correction features
  Align to Baseline 105
  Align to Dissociation 105
Invert Selection, display option 132
Iso-Affinity graph
  described 139
  X and Y axis (figure) 139

K
KD (M), kinetic analysis result 129
kdis (1/s), kinetic analysis result 129
kdis Error, kinetic analysis result 129, 130
kinetic analysis results
Assoc. (Sample) Loc. 129
Baseline Loc. 129
Color 129
Conc (nM). 129
Cycle 130
Dissoc. Loc. 129
Full R2 130
Full X2 130
Include 129
Index (parameter)
  working with analyzed data
    kinetics analysis 129
KD (M) 129
kdis (1/s) 129
kdis Error 129, 130
km 130
km error 130
kobs (1/s) 130
kon (1/Ms) 129
kon Error 129
Loading Well Location 130
Report point #1-10 130
Req/Rmax (%) 130
Response 129
Rmax 129
Rmax Error 129

Sample ID. 129
Sensor Info 129
Sensor Location 129
Sensor Type 129
SSG KD 130
table, listed 129
kinetic analysis types
  Curve fitting 113
  Steady state analysis 113
kinetic assay, displaying selected step (figure) 93
kinetic constants 80
kinetic data
  analyzing 114
  processing 96
kinetic Settings_DataAnalysis.ini file, creating 119
kinetic Settings_TableInfo.xml file, creating 120
kinetic Settings_WellInfo.xml file, creating 120
kinetics analysis mode, returning to 96
kinetics analysis results 123
Kinetics Batch Mode (menu) 24
Kinetics Batch Mode—Quantitation Batch Mode dialog box (figure) 121
kinetics experiment
  closing 87
starting 76
km error, kinetic analysis result 130
km, kinetic analysis result 130
Known Conc. 63
kobs (1/s), kinetic analysis result 130
kon (1/Ms), kinetic analysis result 129
kon Error, kinetic analysis result 129

L
launching Octet System Data Acquisition software 22
Legend by, view option 126
license information, displaying 26
ligand biosensor location 111
ligand biosensors, defined 96
Linear Point to Point 59
list options 186
Load Standards menu 60
Loaded Data Directory Tree 45
Loaded Data directory tree 76
loading
   experiment for analysis 76
   experiment method file 24
Loading Well Location, kinetic analysis result 130
location

of the biosensor in the sensor tray map 129
of the sample well used during the load step of the experiment 130
Lock Application menu 25
locking a user session 41
Logoff menu 25
Lot Number, analyzed data 62
Low concentration threshold, processing parameters
   basic kinetics 83
   Quantitative Analysis 48

M
Mass Transport 114
mass transport rate constant 130
matching search term with searchable text 132
mathematical model, generates fitted view 114
Max Residual, threshold value 63
measure of the goodness of curve fitting 130
menu bar, Octet System Data Acquisition software 23
menu commands, listed 24
method files
   generated 36
opening 76
Min Sample r2, threshold value 63
Model options
  1 to 1 114
  1 to 2 Bivalent Analyte Model 114
  2 to 1 (HL) Model 114
  Mass Transport 114
Model, curve fitting kinetics analysis option 114
modified parameters, saving
  basic kinetic analysis 83
  quantitative analysis 49
molar concentration of the sample used in the association step 129
multiple kinetic data sets, processing 119
multiple quantitation data sets, processing 67

N
New Group window 179
New Project window 181
new software for 21 CFR Part 11 (new feature) 18
new software for ForteBio GxP Server module (new feature) 18
non-equivalent surface capacity 115
non-specific binding of sample 101
number of biosensor regeneration cycles 130
numbered order of the curves processed 129

O
observed binding rate 130
Octet instrument labels 20
Octet instrument to computer, connecting 22
Octet System Data Acquisition software launching 22
  main toolbar 23
Octet system, described 6
opening
  binding curve chart in a separate window
  kinetics 86
  quantitative 56
Kinetics Batch Mode 24
online Data Acquisition User Guide 26
Quantitation Batch Mode 24
web browser 26
Operator, Advanced Search option 132
Options (menu) 24
options for viewing results 107
Options, Fitting view option 124
Order Columns, display option 132

**P**

Parallel Reference Sensors
- reference subtraction method (figure) 102
described 101
Partial, analysis option 114
plate number 62
preparing samples for quantitation or kinetics experiments 6
printing binding chart 113
Process Data button 106
processed data
  - in the sensor summary view (figure) 110
  - saving 112
processing
  - data 106
  - kinetic data 96
  - options, listed 143
processing parameters
  - basic kinetics
    - Low concentration threshold 83
    - Read time 83
    - Zero concentration threshold 83
  - editing 48, 83
editing in the Results window (figure) 49
Quantitative Analysis
  - Low concentration threshold 48
  - Read time 48
  - Zero concentration threshold 48
Processing window
described 96
Raw Data view selected (figure) 89
Raw Data view, displaying data from a single selected biosensor (figure) 90
Raw Data view, quantitating a selected step (figure) 92
project administration 181
project settings
  - changing 182
  - viewing 182
projects
  - changing during a user session 40
  - creating new 181
  - deleting 182
Projects tab 181
properties, for Octet System software, displaying 26
Quantitation Batch Mode, opening 24
Quantitate Selected Step menu 91
quantitating raw data
  for a selected step (figure) 92
  from a selected step, described 91
Quantitation Batch Mode dialog box (figure) 70
Quantitation Batch Mode menu 70
quantitation experiment, described 44
quantitation results report, saving 73
quantitation results reports, exporting data 71
Quantitation window, displaying selected step data from a kinetic assay (figure) 93

Raw Data view 88
Read time, processing parameters
  basic kinetics 83
  Quantitative Analysis 48
reference biosensors
  defined 96
  specifying 97
reference buffer wells, defined 96
Reference subtraction average of methods (figure) 58
Reference Subtraction Average of viewing option
  basic kinetics analysis 85
  quantitative analysis 54
reference subtraction methods
  Average Reference Sensors 103
  Double Reference 102
  Double Reference (figure) 103
  for data processing 100
  Parallel Reference Sensor (figure) 102
  Parallel Reference Sensors 101
  Reference Wells 100
  Reference Wells (figure) 101

R equilibrium
  binding rate equation 60
  steady state kinetics analysis option 118
r2 (COD), analyzed data 63
r2 of the curve fit 63
rate of association 129
rate of dissociation 129
ratio of Req to Rmax 130
Reference Subtraction option 54
Reference Subtraction options
  basic kinetics analysis
    All 85
    Column 85
    Row 85
  quantitative analysis
    All 54
    Column 54
    Row 54
reference subtraction, applying during data processing 99
Reference Well menu 98
Reference Wells
  confirming subtraction (figure) 100
  reference subtraction method 100
  reference subtraction method (figure) 101
  specifying (figure) 99
Refresh, Fitting view option 124
Remove All, Fitting view option 125
Remove Level, Advanced Search option 133
removing all kinetics experiments from processing (figure) 88
Replicate Groups
  adding from the Sample Plate Table 52
  analyzed data 62
  assigning in the Sample Plate Map 50
  assigning in the Sample Plate Table 52
  defining 49
Replicate Groups displayed
  in Sample Plate Map (figure) 51
  in Sample Plate Table (figure) 52
replicates 60
report data types
  analysis options, kinetics analysis results (figure) 147
  Experiment Summary options (figure) 143
Processing options
  processed data (figure) 145
  raw data and aligned data (figure) 144
  Report Point analysis (figure) 146
  sensor tray and sample tray information (figure) 144
Report point #1-10, kinetic analysis result 130
Report Point Analysis features
  Apply 111
  Apply All 111
  Export File 111
  in the Analysis window 110
  Input times after beginning of Association Step 111
listed 111
Use 20 point average 111
Report Point Analysis table 110
Report Points
  Add to Table 125
  Fitting view option 124
  Remove All 125
  Time (sec) 124
  Use__Point Average 125
Report Points view
  described 110
  processed results (figure) 111
Report Selection form (figure) 142
reports
  generating 141
  saving 24
Req/Rmax (%), kinetic analysis result 130
Residual view
  individual option (figure) 125
  stacked option (figure) 124
Residual, analyzed data 63
response calculated from the time window entered in the Steady State Analysis section 129
response maximum, calculating 115
Response, kinetic analysis result 129
Response, steady state kinetics analysis option 118
Restart Server console (figure) 191
Restart Server desktop icon (figure) 190
restarting ForteBio GxP Server module 190
results
  color-coding by category 135
  grouping 126
  table, described 63
  viewing options 107
Results table
  searching contents 133
Results window
  for a quantitation experiment (figure) 61
  showing standards sample alerts (figure) 64
  with calculated binding rates (figure) 96
returning
  to kinetics analysis mode 96
  to the originally configured ForteBio GxP Server module settings 189
Rmax
  defined 115
  kinetic analysis result 129
Rmax Error, kinetic analysis result 129
Rmax unlinked 115
Rmax Unlinked option for Global Fitting, curve fitting kinetics analysis option 115
running
batch kinetics analysis 121
batch quantitative analysis 70

defined 63
sample tray map, using 97
sample type, changing 93
sample well location in the sample plate 129
Save All Method Files (menu) 24
Save Analysis Settings menu 69
Save Data Analysis Parameters button—Analysis window (figure) 118
Save Report menu 141
Save Results options 112
saving
all reports 24
analysis results
for each biosensor to a separate text file 141
for selected biosensors to system clipboard 141
analysis settings 66
binding data
for each biosensor to a separate text file 141
for selected biosensors to system clipboard 141
processed data 112
processing parameters 112
quantitation results report 73
raw data 71, 112

Sample Alert
described 65
threshold value 63
sample alerts, applying 65
sample concentration
computed from the standard curve 63
defined 112
determining 44
sample designations
changing
kinetics analysis 81
quantitative analysis 46
sample ID 111
sample ID entered during assay setup 129
Sample ID, analyzed data 62
Sample ID, kinetic analysis result 129
sample location 111
sample plate map
copying 97
results 112
results options 112
results table to a .csv file 141
standards data 66
Savitzky-Golay filtering 106
scatter plot 138
Search all but keep current selection (implies OR), Advanced Search option 133
Search All, Advanced Search option 133
Search only current selection (implies AND), Advanced Search option 133
search result, defined 132
search term for a single level 132
search, editing a 134
searching contents of the Results table 133
Security menu 25
Security menu commands, listed 25
Select All Rows, display option 132
selecting
    adjacent rows, for viewing data 127
    analysis results for viewing in the Fitting view and Residual view (figure) 128
biosensors 97
biosensors for analysis (figure) 80
biosensors for the analysis 79
biosensors in the Processing window (figure) 97
biosensors to be analyzed (figure) 106
contiguous and discontiguous biosensors in the Sensor location list (figure) 91
experiments and run the batch analysis 121
experiments and running the batch analysis 70
experiments for batch analysis (figure) 71
non-adjacent rows or wells
    kinetics analysis 84
    quantitative analysis 53
non-adjacent rows, for viewing data 127
sample wells or rows to display in the binding curve graph
    basic kinetic analysis (figure) 84
    quantitative analysis (figure) 53
server location 30
standard curve equation 59
Sensor Info, kinetic analysis result 129
Sensor Location, kinetic analysis result 129
sensor summaries (figure) 145
Sensor Summary view
    defined 109
    displayed (figure) 110
features 109
sensor tray map
  copying 97
  using 97
Sensor Tray tab 79
Sensor Type
  analyzed data 62
  kinetic analysis result 129
sensor, analyzed data 62
Sensors to be Analyzed box 99
Server Administration menu 25
server location, selecting 30
Set Color By Group, display option 131
Set Color By, display option 131
Set Color menu 134
Set Color, display option 131
Set Well Data dialog box (figure) 50
setting
  concentration values (figure) 95
  data color by category 136
setting up administrator account,
  administrator account, setting up 165
Settings_DataAnalysis.ini file, creating 68
Settings_DataAnalysis.xml file 119
Settings_WellInfo.xml 119
Settings_WellInfo.xml file 70
shortcut menu of display options, viewing 131
Show All Steps Aligned alignment option 91
Show All Traces viewing options
  basic kinetics analysis 85
  quantitative analysis 54
Size Columns by Data, display option 132
Size Columns by Title, display option 131
sorting
  analysis results by any category 137
  Audit Trail events 39
  results table entries in ascending order 63
  results table entries in descending order 63
specifying
  analysis settings 58
  reference biosensors 97
  Reference Wells (figure) 99
SSG KD, kinetic analysis result 130
Stacked, Fitting view option 124
standard concentration information, editing 48
standard curve equation, selecting 59
standard error of Rmax 129
standard error of the mass transport rate constant 130
standard error of the rate of association 129
standard error of the rate of dissociation 129
standards alert, applying 64
standards data, saving 66
starting
  basic kinetics experiment 76
  user session 33
steady state analysis 80
Steady State Analysis graph
described 140
displayed (figure) 140
Steady state analysis, kinetic analysis type 113
steady state kinetics analysis options 118
  Average from 119
  R equilibrium 118
  Response 118
Steps to Analyze, curve fitting kinetics analysis option 114
Subtraction check box 99
sum of squared deviations 130
symbols
  electrical hazard 20
  fuse 20
  heat/hot 20
system artifacts 101
system drift 100
T
Table Information, batch mode option, kinetics 122
technical support, contacting 20
testing, ForteBio GxP Server module 189
threshold values
  Do not use alerts 64
  Max Residual 63
  Min Sample r^2 63
  Sample Alert 63
Time (sec), Fitting view option 124
Time 1 (sec) 112
Time 2 (sec) 112
time range
  of the association step data to analyze 115
  of the dissociation step data to analyze 115
time, at which the first binding measurement is acquired 112
toggling sample analysis in the Results window 47, 81
Treat Empty Cells as Match, Advanced Search option 133
types of report data included by the Processing options (figure) 147
U

Unweighted) 59
Use “Included” Traces Only check box 126
Use 20 point average 111
Use Entire Step Times, analysis option 115
Use one for all folders, batch mode option
  kinetics 121
  quantitation 70
Use standards from loaded file check box 60
Use the one in each folder, batch mode option
  kinetics 121
  quantitative 70
Use the original data folder, batch mode option 70
Use this folder, batch mode option 70
Use _Point Average, Fitting view option 125
user account
  creating 174
  deleting 176
user account password, changing 177
user account settings
  changing 176
  viewing 176
user group
  creating new 179
  deleting 180
user password, changing 41
user session
  changing projects during 40
  ending 42
  locking 41
  starting 33
user-selected results, changing color (figure) 135
user-specified
  ligand biosensor information 111
  notes, about the wells 63
  standard concentration 63
using
  data analysis session 44
  sample tray map 97
  sensor tray map 97
V

Value, Advanced Search option 132
Verify Digital Signature dialog box (figure) 36
Verify Document menu 25
verifying digital signatures 36
View Audit Trail menu 25
viewing

Audit Trail 38
binding curves
  basic kinetic analysis 84
  quantitative analysis 53
constants 184
events for a specific project or computer 39
events for a specific user account, project or computer 186
group settings 180
project settings 182
raw data 88
results, options 107
shortcut menu of display options 131
specific biosensor data 127
user account settings 176

viewing options
basic kinetics analysis
  Align X 85
  Edit Legends 85
  Ignore errors in files when loading 85
  in the Data Selection window (table) 85
  Reference Subtraction Average of 85
  Show All Traces 85
quantitative analysis
  Align X 54
  Edit Legends 55
  Flip Data 54, 85
  Grouped View 54
  Ignore errors in files when loading 54
  in the Data Selection window (table) 54
  Reference Subtraction Average of 54
  Show All Traces 54
selecting data 127

W
web browser, opening 26
Weighted Y2) 59
well concentration 62
well designation 62
Well Information
analyzed data 63
batch mode option
  kinetics 121
  quantitation 70
  editing 48
well location 62
in the sample plate 62
in the sample plate or reagent plate 129
wells, excluding from analysis 99
Window of Interest (From Start of Step), analysis option 115

X
X-Y graph
described 138
displayed (figure) 138

Y
Y Axis Scaling
  Auto Scale 124
  Fitting view option 124
  Full Scale 124
Y axis, aligning (figure) 105

Z
Zero concentration threshold, processing parameters
  basic kinetics 83
  Quantitative Analysis 48